This document is intended for use by RISO, its authorized dealers and purchasers of the equipment described herein. While every effort has been made to insure the accuracy of information contained in this document, RISO, its authorized dealers and their employees shall not be held responsible for any inaccuracies it may contain.

ALL SPECIFICATIONS ARE SUBJECT TO CHANGE WITHOUT NOTICE.

Reproduction or copying of this manual or any parts thereof without permission is strictly prohibited.

Although every effort has been made to ensure that the contents of this manual are error-free, please contact us if you notice any errors or other points which should be brought to the company's attention.

The following paragraph is required for the German Market.

MASCHINENLÄRMINFORMATION
Maschinenlärminformationsverordnung 3. GSGV, 18.01. 1991:
Der höchste Schalldruckpegel beträgt 70 dB(A) oder weniger gemäß ISO 7779.

FCC warning
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference, in which case the user will be required to correct the interference at his own expense.

Copyright© 2001 RISO KAGAKU CORPORATION, JAPAN

Adobe, Adobe Type Manager, Adobe PS, ATM, Brilliant Screens, PostScript, PostScript3 and PostScript logo are (registered) trademarks of Adobe Systems Incorporated in the U.S.A. and other countries.

AppleTalk, Macintosh and MacOS are trademarks of Apple Computer, Inc., registered in the U.S.A. and other countries.

Windows and Windows NT are registered trademarks of Microsoft Corporation in the U.S.A. and other countries.

Netscape and Netscape Navigator are registered trademarks of Netscape Communication Corporation in the U.S.A. and other countries.

JavaScript is (registered) trademark of Sun Microsystems, Inc. in the U.S.A. and other countries.

Product names and company names that are referenced in this guide are (registered) trademarks of the respective companies.
Thank you for purchasing the RISO SC7900 Computer Interface.

This product mainly consists of the RIP (raster image processor)-based control box which is placed between your computer and your RISO printer and the print driver programs which are installed in your computer, enabling you to print various documents you create on different computer platforms directly to your RISO printer.

The SC7900 converts your RISO printer into the PS printer which supports PostScript 3 with nearly 200 kinds of PS fonts stored in the hard disk in the control box. When your RISO printer is recognized as a PostScript printer, your computer sends print data to the SC7900 in the form of PostScript codes, which are developed into a full-page bitmap (raster) image in the SC7900 and sent to your RISO printer, realizing a high-quality print in a short time.

As another extended feature, the SC7900 is equipped with the Ethernet (10BASE-T and 100BASE-TX) ports, allowing multiple persons to share your RISO printer in both printing and scanning operations in LAN environment with TCP/IP or EtherTalk as network protocol.

To allow any person in LAN environment to find the current status of the SC7900 control box and/or the RISO printer or use the SC7900 as file server for document management, furthermore, a graphically-designed easy-to-understand status monitoring and document management screen can be provided as a utility tool in any networked computer.

About this User’s Guide

This guide is one of the two booklets provided to enable you to make full use of the capabilities of the RISO SC7900 Computer Interface, written on the assumption that all related hardware units have already been connected to your system and all software programs required for the operations described here have already been installed in your computer.

In this user’s guide, the basic operations required to print your documents created on your computer directly to your RISO printer are described in the first 3 sections separately for the following different computer system platforms: Windows95/98/Me/2000/NT4.0 and Macintosh.

In these sections, the advanced options which are available in printing your documents are also explained in details for experienced users.

In the following sections, furthermore, detailed descriptions are given for all supported computer system platforms, to instruct you on how to find the current status of the SC7900 control box and/or your RISO printer on your computer, manage documents under a unique queue structure and scan images from your RISO printer into your computer through the SC7900 control box.

In the last section, the troubleshooting tips are provided to help you in case you
have any problem in operation.

Read the section which corresponds to your computer system platform or your desired operation before using your SC7900 or whenever you have questions in operation.

If you want to know how to configure the SC7900 control box and your RISO printer in your computer system and/or how to install the SC7900-related software programs into your computer, refer to another booklet provided, i.e. Technical Administrator’s Guide, in which more specialized information is also available to optimize the performance of your SC7900 in your computer environment.

**NOTE** The expressions which are used in the UK-ENG printer driver program and different from those used in the US-ENG one are given in the brackets.

---

**About the Alert Notices**

The following alert notices are used in this manual to alert a user to operate the SC7900 correctly and prevent damage or injury.

⚠️ **WARNING**
indicates a potentially hazardous situation which, if disregarded, might result in serious injury.

⚠️ **CAUTION**
indicates a potentially hazardous situation which, if disregarded, might result in injury or physical damage.

**IMPORTANT**
gives you helpful advice for trouble-free operation.
# Table of Contents

Preface ............................................................................................................. 2  
About this User's Guide ............................................................................... 2  
About the Alert Notices .............................................................................. 3  

Table of Contents .......................................................................................... 4  

## Before Using Your SC7900

Safety Guides ................................................................................................. 8  
Power Connection ......................................................................................... 8  
Operation Environment ................................................................................ 8  
Handling Precautions ................................................................................... 9  
Front Panel Features .................................................................................... 10  
Indicators and Buttons ................................................................................ 10  
Panel Signs and Operations ......................................................................... 11  

## Printing from Windows PC

Sending and Printing Data ........................................................................... 14  
Setting the Print Conditions ...................................................................... 17  
  [Graphics] Tab (Windows 95 / 98 / Me) .................................................... 25  
  [Advanced] Tab (Windows NT4.0) /  
    [Advanced] Dialog Box (Windows 2000) ............................................ 26  
  [SC7900] Tab-[Layout] Window .............................................................. 29  
  [SC7900] Tab-[Coloring (Colouring)] Window ....................................... 32  
  [SC7900] Tab-[Halftones] Window ........................................................ 34  
  [SC7900] Tab-[Output] Window .............................................................. 36  
  [SC7900] Tab-[Forms] Window ............................................................... 38  

Creating a PS File ........................................................................................... 41  

Using Forms .................................................................................................. 43  
  To Register Forms .................................................................................... 43  
  To Apply Forms in Print Jobs .................................................................... 43
# Table of Contents

## Printing from Macintosh

Sending and Printing Data .................................................. 46

Setting the Print Conditions ............................................... 50
  [Page Setup] Dialog Box .................................................. 50
  [Print] Dialog Box ......................................................... 52
  [Page Attributes] Card .................................................... 57
  [Watermark] Card ........................................................... 59
  [PostScript™ Options] Card ............................................... 60
  [SC7900 Layout] Card ....................................................... 62
  [SC7900 Forms] Card ........................................................ 65
  [SC7900 Utility] Card ........................................................ 66
  [SC7900 Halftones] Card ................................................... 67
  [SC7900 Output] Card ........................................................ 68
  [SC7900 Coloring (Colouring)] Card ..................................... 70
  [Background Printing] Card ............................................... 72
  [Cover Page] Card ............................................................ 73
  [Color Matching] Card ...................................................... 74
  [Layout] Card ................................................................. 75
  [Error Handling] Card ........................................................ 76
  [PostScript Settings] Card .................................................. 77
  [Printer Specific Options] Card .......................................... 79

Creating a PS File ................................................................... 80

Using Forms ........................................................................... 81
  To Register Forms ............................................................... 81
  To Apply Forms in Print Jobs ............................................... 81

## Using the RISO Console II

RISO Console II Overview ..................................................... 84

Viewing Properties - SC7900/Queue/Job .................................. 85

Navigation Guide in the Main View Window .............................. 85

[RISO Console II - SC7900 Details] Dialog Box ....................... 86

[RISO Console II - Queue Details] Dialog Box .......................... 88
[RISO Console II - Job Details] Dialog Box ................................................. 89

Monitoring the SC7900 Communication Status ........................................ 91

Monitoring the Current Status of RISO Printers ...................................... 92

Managing Jobs (Processed Documents) ....................................................... 95

Exporting Processed Document Data for
  Preview (Job Feedback) ........................................................................... 97

Merging Document Files ............................................................................ 99
  File Merge Options ................................................................................. 99

Printing PostScript / PDF Files .................................................................. 101
  Printing Procedure .................................................................................. 101

Viewing the List of Installed Fonts .............................................................. 102

Extending the Search Range for SC7900 .................................................... 103

Changing the RISO Console II Properties ................................................... 104

Scanning Images on your RISO Printer

  RISO Printer Scanning ............................................................................. 106
    Importing Scanned Images directly into a Document Page ...................... 107
    Saving Scanned Images as TIFF Files .................................................... 109
    Exporting Scanned Images through the RISO Console II ......................... 111
  Scanning Images .................................................................................... 111
  Exporting Images .................................................................................... 111

Appendix

  Viewing SC7900 Configuration in an Internet Browser ............................. 114
  Web Site Overview .................................................................................... 114

  Troubleshooting Tips .............................................................................. 116
  Operation Problems .................................................................................. 116

Index ............................................................................................................ 120
  Windows .................................................................................................... 120
  Macintosh ................................................................................................ 123
Before Using Your SC7900

Safety Guides.............................................8
Power Connection.......................................8
Operation Environment.................................8
Handling Precautions.....................................9
Front Panel Features.....................................10
Indicators and Buttons..................................10
Panel Signs and Operations............................11
This section explains the precautions you have to observe when handling the SC7900. Read this section before using your SC7900 for the first time.

**Power Connection**

⚠️ **WARNING**
- To avoid an electric shock and personal injury, the SC7900 enclosure may not be opened except by a qualified service technician. The service technician must switch the SC7900 off and unplug the mains supply before opening the enclosure.

It is most important to check the local supply voltage and to set the voltage switch on the rear of the SC7900 according to the local voltage before attempting to connect the SC7900 to the mains supply. See the chapter "Configuring the SC7900-RISO Printer Printing Station" of the *SC7900 Technical Administrator's Guide* for information on how to set the voltage switch correctly and how to connect the SC7900 to the mains supply.

- Do not overload an electrical outlet or extension cord, nor damage the power cord by placing heavy objects on it or pulling or bending it. Otherwise, a fire or an electric shock might occur.

- Do not plug or unplug the power cord if your hands are wet. Otherwise, an electric shock might occur.

⚠️ **CAUTION**
- Do not pull the power cord but hold the plug itself when unplugging it. Otherwise, it could become damaged and a fire or an electric shock might occur.

**IMPORTANT**
- Check the power plug for poor connections. Plug the power cord securely into a nearby electrical outlet.

**Operation Environment**

**IMPORTANT**
- Select a level location.

- Operate the unit under the following appropriate ambient environment conditions.
  - Temperature range: 41°F to 104°F (5°C to 40°C)
  - Humidity range: 40% to 70% (noncondensing)
Handling Precautions

⚠️ WARNING

- To prevent overheating and the possibility of fire, do not cover the air vents.
- Do not insert or drop any metallic material or flammable substance into the unit through any opening. Otherwise, a fire or an electric shock might occur.
- Do not disassemble or rebuild the unit by yourself. Otherwise, a fire or an electric shock might occur.
- If the unit gets uncomfortably hot, smokes or smells bad, immediately turn off the power, unplug the power cord and contact your service representative because a fire or an electric shock might occur.
- If something drops inside the unit, turn off the power switch first, then unplug the power cord and contact your service representative. If you continue using it, a fire or an electric shock might occur.

⚠️ CAUTION

- Unplug the power cord, if you do not use the unit for a long time.

🌿 IMPORTANT

- Do not place heavy objects on or apply shocks to the SC7900.
- Do not remove the front panel.
- The SC7900 incorporates precision parts. Never attempt to take any actions that are not written in this guide.
Indicators and Buttons

**ERROR indicator (orange)**
Indicates the error status of the RISO printer.
**ON:** Indicates that the RISO printer’s operation has been interrupted.
**Flashing:** Indicates that the RISO printer’s power is not on, that the cable between the RISO printer and this unit (SCII cable) is disconnected, or that the RISO printer is operating without SC7900 control.

**READY / DATA indicator (green)**
Indicates the data processing status of the SC7900.
**ON:** Indicates that the SC7900 is idle and free to receive data.
**Flashing:** Indicates that the SC7900 is receiving data or busy processing received data.

**PAGE STANDBY indicator (yellow)**
**ON:** Indicates that the SC7900 is ready to send the whole page data to the RISO printer.
**Flashing:** Indicates that the SC7900 is requesting the RISO printer’s operation to be restarted after it is suspended.

**STOP button**
Suspends a print job or restarts it, skipping the current page.
When pressed together with the FUNCTION button, besides, this button cancels the current print job.

**START button**
Restarts a suspended print job.

**FUNCTION button**
Restarts a suspended print job, making another master for the current page.
When pressed together with the STOP button, besides, this button cancels the current print job.

**POWER button**
Used to turn on and off the SC7900.

**NOTE**
When this button is pressed to turn off the SC7900, it takes several minutes to close the power supply because the safety shutdown process is proceeding inside.
Panel Signs and Operations

If the RISO printer's operation is interrupted and the ERROR indicator on the SC7900 front panel is illuminated, check the RISO printer and take the necessary action.

When the RISO printer has been reset, the PAGE STANDBY indicator starts flashing, indicating that the RISO printer is waiting to be restarted. There are several ways to do this depending on how the RISO printer was interrupted:

• **When the operation was interrupted during the printing process;**
  • Press the START button (or the Interface key on the RISO printer) to keep on printing the current page.
  • Press the STOP button to proceed to make a master for the following page without printing the remaining copies of the current page.
  • Press the FUNCTION button to make another master for the current page and print the remaining number of copies.
  • Press the STOP button and the FUNCTION button together to cancel the current print job.

• **When the operation was interrupted during the master-making process;**
  • Press the START button (or the Interface key on the RISO printer) to proceed to print the current page.
  • Press the STOP button to proceed to make a master for the following page without printing the current page.
  • Press the FUNCTION button to remake a master for the current page.
  • Press the STOP button and the FUNCTION button together to cancel the current print job.

<Recovery Pattern Chart with Front Panel Button Operation>

![Flowchart showing the recovery pattern]
Printing from Windows PC

Sending and Printing Data .................. 14
Setting the Print Conditions ............... 17
  [Graphics] Tab (Windows 95 / 98 / Me) .... 25
  [Advanced] Tab (Windows NT4.0) /
    [Advanced] Dialog Box (Windows 2000) .... 26
  [SC7900] Tab-[Layout] Window ......... 29
  [SC7900] Tab-[Coloring (Colouring)] Window .... 32
  [SC7900] Tab-[Halftones] Window ......... 34
  [SC7900] Tab-[Forms] Window ............. 38

Creating a PS File ......................... 41
Using Forms .................................. 43
  To Register Forms ......................... 43
  To Apply Forms in Print Jobs ............. 43
Follow the procedures given below to print out document data on the RISO printer through the SC7900.

If the dedicated printer driver program has not been installed in your personal computer yet, request your Technical Administrator to install it first.

1. **Turn on the RISO printer and load paper.**
   Load paper whose size is the same as defined in the document file to be printed.

2. **Turn on the SC7900 and your personal computer.**

3. **Open the document file to be printed.**
   
   **NOTE** Always select a SC7900 queue as [Default Printer] before you open or create a document file to be printed. Otherwise, the document might not be printed properly.

4. **Specify the print job in the [Print] dialog box.**
   Select [Print] in the [File] menu to open the [Print] dialog box.
   
   **NOTE**
   - Never fail to deselect the [Collate] box. If it is selected, the master-making operation will be repeated for every copy.
   - The items displayed in the [Print] dialog box vary depending on the application software.

   ![Print dialog box](image)

   [Printer:]
   Make sure that a SC7900 queue is selected in the [Name] field.
   If you want to select another SC7900 queue, click on the [V] bar in the [Name] field and select a desired one from the displayed list. There are two types of queues, "normal queue" and "hold queue", available in the SC7900. The queue type is displayed next to [Where] as the directory in the SC7900 hard disk to which the selected document file is to be sent. For more details, contact your Technical Administrator.
NOTE When the SC7900 is connected to your computer with the parallel cable, only one queue, default "normal queue", is available. In this case, you cannot use the queue-based print management structure which is provided by the SC7900.

[Copies:] Specify the number of copies to be printed within the following range: 1 to 9,999.

If you want to set additional print conditions for the current print job; Open the [Properties] (or [Document properties]) dialog box by clicking on the [Properties] button.

For a detailed description of this dialog box, refer to page xx.

"Normal queue" and "hold queue"
When using the SC7900 through the network port of your computer, document data sent from your computer is temporarily stored in a location, called "normal queue", in the hard disk of the SC7900, and will be printed out later after all preceding ones stored there and then deleted after it is printed.

When the document data is stored in another location, called "hold queue", in the SC7900 hard disk, on the other hand, it will not be printed out unless you give an additional print order later. To print out the document data stored in the "hold queue", activate the dedicated status monitoring and document management utility program, RISO Console II, and follow required steps. (See page 93.)

Even after printed out, the document data stored in the "hold queue" stay there for repeated output, form creation or document feedback. If required, you can also change the print conditions of the document data stored in the "hold queue".
5 Start printing.

Click on the [OK] (or [Print]) button in the [Print] dialog box. The READY/ DATA indicator on the SC7900 starts flashing, indicating that data processing has started.

When data processing is completed, the PAGE STANDBY indicator lights and the RISO printer starts printing.

**NOTE**

- If you select a "hold queue" as print destination, the processed document data stay in the SC7900 and are not printed out on the RISO printer even after the PAGE STANDBY indicator lights.

- You can check and control the current print job process directly from your personal computer with the dedicated status monitoring utility program, RISO Console II. (See page 96.)
Setting the Print Conditions

You can set various print conditions using the [Properties] dialog box, which appears when you click on the [Properties] button in the [Print] dialog box.

In the [Properties] dialog box, an originally-designed multi-window tab is prepared to enable you to select desired print conditions easily for print jobs with the SC7900, in addition to the regular tabs, in which you can select the common print conditions for PostScript printers.

- The items whose setting is supposed to be required in printing with the SC7900 as well are only explained for the regular tabs in the following pages.
- The options which are available in the regular tabs vary depending on the version of the Adobe PS printer driver.

---

**[Paper] Tab (On Windows 95/98/Me) / [Paper Setup] Tab (On Windows NT4.0) (See page 22.)**

- Paper size
- Layout
- Orientation
- Paper source
- [Unprintable Area] button
- [Restore Defaults] button

---


- Orientation
- Page Order
- Page Layout
- Page Source
- [Advanced] button
Setting the Print Conditions

[Graphics] Tab (On Windows 95/98/Me) (See page 25.)

a. Special
b. Scaling


**NOTE**

a. Paper size
b. Scaling
c. TrueType Font
d. Page Layout
e. PostScript
   Options
[SC7900] Tab-[Layout] Window (See page 29.)

a. Use Queue settings  
b. Pattern  
c. Sorter control  
d. Stapler  
e. Rotated (Rotated 180°)  
f. Mirror binding  
g. Creep compensation  
h. Shift

[SC7900] Tab-[Coloring (Colouring)] Window (See page 32.)

NOTE  
This window appears only when the twin-cylinder (-drum) printer is selected as connected output device.

a. Use Queue settings  
b. Use auto cylinder (drum) selection  
c. Text/Line-art processing  
d. Color (Colour) density level

[SC7900] Tab-[Halftone] Window (See page 34.)

a. Gamma control  
b. Screen type
Setting the Print Conditions

**[SC7900] Tab-[Output] Window (See page 36.)**

a. Print speed  
b. Print density  
c. Confidential mode  
d. Process  
e. Proof copies  
f. Job separator  
g. Reset before first  
   Master

**[SC7900] Tab-[Forms] Window (See page 38.)**

a. Merge form  
b. Copy form to Clipboard  
c. Preview

**[SC7900] Tab-[Utility] Window (See page 39.)**

a. Send e-mail messages  
b. Delegation  
c. Destination
[SC7900] Tab-[About] Window

**NOTE**

Shows the version number of the current SC7900 printer driver

(Windows 95 / 98)

(Windows NT4.0)

a
b
c
d
e
f

a. Paper size

Changing the standard paper size setting

When using any standard size of paper other than that highlighted (or displayed), highlight another paper size in the list by clicking on it (in the [Paper] tab) or click on the ▼ bar to display a list of paper sizes and select a desired one by highlighting it (in the [Page Setup] tab). The factory-set paper size is Letter or A4.

Changing the custom paper size setting

When using any custom-size paper other than those given in the "Paper size" list, select Custom 1, 2 or 3 in the list and click on the [Custom Size] button (in the [Paper] tab) or select [PostScript Custom Page Size] in the list and click on the [Edit Custom Page] button (in the [Page Setup] tab). In the dialog box shown below, you can enter desired width and length, under a desired name (in the [Paper] tab) or with the feed direction (in the [Page Setup] tab).

For a detailed description of allowable paper range, refer to the User's Guide of your RISO printer.
b. Layout

You can specify the number of pages to be printed on a single sheet of paper for multiple-page documents from 1, 2, 4, 6, 9 or 16 pages.

**NOTE** • A different type of layout feature is available in the [Layout] window of the [SC7900] tab.
• Some application programs do not support this option.

c. Orientation

You can specify the orientation of print on the page. The factory-set orientation is "Portrait". As an option, upside-down images are available for the "Landscape" format.

**NOTE** • The page dimensions and margins of the selected print orientation are displayed by clicking on the left-hand paper icon. To change the measurement unit, click on the icon while holding down the [Shift] key (in the [Paper] Tab).

d. Paper Source

You can select the paper tray when the RISO printer is equipped with the Multi-tray paper feeder. Click on the [V] bar and select one of the following items from the displayed list:

<Open>:

Paper is fed from the tray selected on the control panel of the RISO printer.

Auto:

Paper is fed from the tray which is to be selected automatically according to the page format of original document data.

Standard tray / Feed tray 1 / Feed tray 2:

Paper is fed from the tray selected here.

**NOTE** • The Standard tray may not be included in the candidates for auto selection depending on the configuration of the RISO printer.

e. [Unprintable Area] button

Opens the [Unprintable Area] dialog box, in which you can change the margin settings for the current print job within the given ranges.

**NOTE** • If you want to keep the new margin settings for other print jobs, contact your Technical Administrator.

f. [Restore Defaults] button

Returns all settings in this dialog box to the factory-set (default) ones.

a. Orientation
You can specify the orientation of print on the page. The factory-set orientation is "Portrait". As an option, upside-down images are available for the "Landscape" format.

b. Page Order
You can select in what order document pages should be printed out, i.e. in regular order or in reverse order.

c. Page Layout
You can specify the number of pages to be printed on a single sheet of paper for multiple-page documents from: 1, 2, 4, 6, 9 or 16 pages.

NOTE
- A different type of layout feature is available in the [Layout] window of the [SC7900] tab.
- Some application programs do not support this option.

d. Paper Source
You can select the paper tray when the RISO printer is equipped with the Multi-tray paper feeder. Click on the [V] bar and select one of the following items from the displayed list.

<Open>:
Paper is fed from the tray selected on the control panel of the RISO printer.

Auto:
Paper is fed from the tray which is to be selected automatically according to the page format of original document data.

Standard tray / Feed tray 1 / Feed tray 2:
Paper is fed from the tray selected here.

NOTE
The Standard tray may not be included in the candidates for auto selection depending on the configuration of the RISO printer.

e. [Advanced] button
Opens the [Advanced] dialog box, in which you can set additional print conditions for advanced operations. (See page ##.)
[Graphics] Tab (Window 95/98/Me)

a. Special

Print as a negative image:
You can print your documents in negative images by activating this option. To activate it, select this box.

Print as a mirror image:
You can print your documents in mirrored images by activating this option. To activate it, select this box.

b. Scaling
You can reduce or enlarge the page image in printing according to your needs. The available scale range is 25% to 400%. The factory-set value is 100%.
[Advanced] Tab (Windows NT4.0)/
[Advanced] Dialog Box (Windows 2000)

a. **Paper size**

When using any standard size of paper other than that displayed, click on the [▼] bar to display a list of paper sizes and select a desired one by highlighting it. The factory-set paper size is Letter or A4.

b. **Scaling**

You can reduce or enlarge the page image in printing according to your needs. The available scale range is 1% to 1000%. The factory-set value is 100%.

c. **TrueType Font**

You can specify how the TrueType fonts used for texts in your documents should be reproduced on copies printed on the RISO printer.

**Substitute with Device Font:**

The PS printer fonts stored in the SC7900 are always used for any TrueType font appearing in your document in printing.

Using this setting, the printing time can be reduced but unexpected print results may appear on printed copies due to the use of non-matching printer fonts.

**Download as Softfont:**

For any TrueType font used in your document, the font data itself is sent to the SC7900 and used in printing.

Unexpected print results can be avoided by selecting this setting but it requires more printing time.
d. Page Layout

You can specify the number of pages to be printed on a single sheet of paper for multiple-page documents from: 1, 2, 4, 6, 9 or 16 pages.

**NOTE**
- A different type of layout feature is available in the [Layout] window of the [SC7900] tab.
- Some application programs do not support this option.

e. PostScript Options

**PostScript Output**

You can specify the output format of the PostScript document files from: PostScript [Optimize for Speed], PostScript [Optimize for Portability], Encapsulated PostScript [EPS] or Archive format.

- **PostScript [Optimize For Speed]:**
  Select this option when printing document in most cases.

- **PostScript [Optimize For Portability]:**
  Select this option when creating a file that conforms to the Adobe Document Structuring Conventions (ADSC). Each page of the document will be a fully self-contained object. This is useful if you want to create the PostScript file and print it on a different printer.

- **Encapsulated PostScript [EPS]:**
  Select this option to create EPS file which can be imported as an image in another document.

- **Archive format:**
  Select this option to create PostScript data stream file format. No printer feature is available for this file format.

**TrueType Font Download**

You can specify in what format the TrueType font data should be sent to the SC7900 from:

Outlines (Type 1), Bitmaps (Type 3, Type 32), Native TrueType (Type 42) or Automatic.

- **Outlines:**
  TrueType fonts are sent in scalable outline (Type1) format. In this format, bitmap format is automatically applied if the point size is too small.

- **Bitmaps:**
  TrueType fonts are sent in Bitmap (Type3) format.

- **Native TrueType:**
  TrueType fonts are sent in Type42 format. This format is recommended because typeface quality is maximized if you select it.
Setting the Print Conditions

- **Automatic:**
  The most suitable format in which the TrueType font data is sent to the SC7900 is automatically selected according to your system configuration.

**PostScript Language Level**
You can specify the level of PostScript codes to be used in sending data to the SC7900 or creating PostScript files. Select “PostScript3” in sending data to the SC7900.

**Send PostScript Error Handler**
If you select this option, the PostScript error information is printed whenever an PostScript error occurs.

**Mirrored Output**
You can print your documents in mirrored images by activating this option. To activate it, select “Yes” in the list box below.

**Negative Output**
You can print your documents in negative images by activating this option. To activate it, select “Yes” in the list box below.
[SC7900] Tab-[Layout] Window

NOTE This window can be opened by clicking on the [Settings] button in the entry window of the [SC7900] tab.

a. Use queue settings
If you use the layout design specified in the selected queue of the SC7900 in a print job, tick this option box. When this option is selected, no setting is possible in this window.

b. Pattern
You can select how to arrange pages on a sheet from the given list. The selected layout pattern image is given in the frame below.

Simplex: A single page is arranged on a sheet.

Duplex - Long edge/Short edge:
A single odd or even page is arranged on a sheet, given the binding margin on the long or short edge of the sheet. To arrange odd pages, select "Front" below the image frame and "Back" for even pages.

Duplex - Half-size booklet/Full-size booklet:
Two pages are arranged on a sheet, reducing page sizes to half or keeping original page sizes, to allow you to make half-page-size or full-page-size center-folded booklets. Different page arrangements are provided by changing the printed sheet side selection below the image frame, "Front" or "Back".

NOTE When you select "Duplex - Full-size booklet", make sure that the paper whose size is twice as large as of document page is loaded on the RISO printer.
Setting the Print Conditions

c. Sorter control
You can select an operation mode of the optional sorter which is connected to the RISO printer. Click on the [▼] bar and select a desired one from the displayed list. The factory-set mode is "<Open/Queue>". The modes which can be selected are as listed below.

- **<Open/Queue>:**
  The connected sorter operates as specified in the selected queue of the SC7900.

- **NonSort:**
  Printed sheets are delivered into the Nonsort tray as if no sorter was installed, thus enabling you to process a large-volume print job speedily.

- **Sort:**
  Printed sheets are sorted in order to produce a desired number of copies of a multiple-page document.

- **Group:**
  Printed sheets are distributed into different groups of bins for different document pages. This mode may not be available with certain models of sorters.

- **Stack:**
  Printed sheets are distributed into a series of separate bins repeatedly, thus enabling you to secure ink-smudge-free prints.

d. **Stapler**
You can activate the stapler built in the sorter which is connected to the RISO printer and select the stapling position. Click on the [▼] bar and select a desired option from the displayed list. The given stapling positions are: "at upper left corner", "at 2 points in the head" and "at 2 points along the side". The factory-set option is "<Open/Queue>", which lets the built-in stapler operate as specified in the selected queue of the SC7900. If you do not want to use the stapler, select "OFF".

e. **Rotated (Rotate 180°)**
You can rotate print images by 180 degrees by activating this option with a tick in the option box. This option is useful when the page direction is required to be changed for stapling printed copies or printing on the media whose feeding direction is limited to one way, such as envelopes.

f. **Mirror binding**
You can change the assignment side of binding margins or the booklet page arrangement pattern, supposing that printed sheets are bound on the right side of page, by activating this option with a tick in the option box. The layout pattern image provided in the left-hand frame is also changed accordingly.

g. **Creep compensation**
You can shift images on document pages to compensate for the alignment shift (creep) in a stack of center-folded sheets which are bound to make a booklet, by activating this option with a tick in the option box. Enter a per-sheet compensation range into the box below. The available range is between 0µm and 2000µm.
<Creep compensation is;>

If you bind a stack of center-folded sheets to make a booklet, the side edges of pages do not align due to the thickness of stacked sheets. In normal procedure of booklet making, therefore, the side page edges are trimmed up, based on the cover page. In this case, however, images will be positioned out of line among the pages of the bound booklet. To prevent this resultant alignment shift, i.e. "creep", in booklet pages, it is normal to shift images toward the binding center of a sheet before printing operation while changing the shift range by page depending on the sheet order in the stack. This special adjustment in making booklets of center-folded sheets is called "creep compensation".

To find the shift range value for the respective pages in the creep compensation, first make a temporary booklet using the same number of sheets as required for the final booklet and trim up the side edges of pages. Make sure to use the same quality of paper as to be used in making booklets finally. Then measure the difference of length in the long edges of sheets between the covering one and the innermost one. If you divide this difference value by the number of sheets, you can get the creep compensation value.

h. Shift

You can shift images vertically and/or horizontally on pages while keeping the shift range constant in all pages, by activating this option with a tick in the option box. Enter a desired shift range into the respective boxes below. The available range is between -20000μm and +20000μm.

You can use this option in addition to the print position adjustment on the RISO printer.
[SC7900] Tab-[Coloring (Colouring)] Window

**NOTE**

This window can be opened by clicking on the [Settings] button in the entry window of the [SC7900] tab and then on the [Coloring (Colouring)] icon in the opened window.
The [Coloring (Colouring)] icon and window appear only when the twin-cylinder (-drum) printer is selected as connected output device.

In this window, you can easily specify how to process color document data to be printed out on the twin-cylinder (-drum) printer, given the 2-step cylinder (drum) selection boxes for controlling the process flow and the sample image previews as selection guidance.

*<If you want to print in a single color>*

Tick the selection boxes of a desired color cylinder (drum) while clearing the counterparts of the other one. Only the sample image previews of the selected color then remain in the window.

*<If you want to print in two different colors>*

Tick all selection boxes of both color cylinder (drum) and select desired color elements separately for text/line art and photo images in the respective option fields in the relative sections. The sample previews of selected color-element images which are to be printed in the given colors are shown in the window.

*<Special application in dual-color printing>*

You can make dual-color prints while selecting a single print color for the current document file on your computer. Tick the selection boxes of a desired color cylinder (drum) for the current document file while clearing only the primary selection box of the other one. The current document file is then printed in the selected color, adding the images prepared on the other color cylinder (drum) in advance. This special application is recommended when you print different contents on the same form.
Setting the Print Conditions

= Quick color separation... =

In preparation of coloring process in this window, original color image data are processed based on 4 color-element data, i.e. Red, Green, Blue and Black. When you select one or several color elements of text/line art or photo images for a given color cylinder (drum), the images which contain the selected color element(s) at a high percentage are collected and processed to be printed in the given color.

a. Use Queue settings

If you use the coloring design specified in the selected queue of the SC7900 in a print job, tick this option box. When this option is selected, no setting is possible in this window.

b. Use auto cylinder (drum) selection

If you tick this option box, it is automatically decided based on the color data of the installed print cylinders (drums) what original color image should be printed in which color (red or another) on dual-color prints.

c. Text/Line-art processing

You can select either of the following two styles in printing out colored or gray texts/line-art images in your document data.

To Halftones: The color difference of texts and line-art images can be reproduced as tone difference on prints. In dual-color printing, 70%-halftone-level images, which correspond to red in color, will be reproduced as solid on prints when printed in "Color (Colour) 1", as standard configuration of RISO printers.

To Solid-look: The color difference of texts and line-art images is not reflected on prints and all images are to be reproduced as solid ones there.

d. Color (Colour) density level

You can adjust the contents level of a selected color element in processed image data by shifting the pointer on the sliding bar. If you shift the pointer toward "100%", the contents of the selected color element will be increased, thus causing the image tone darker.
[SC7900] Tab-[Halftones] Window

This window can be opened by clicking on the [Settings] button in the entry window of the [SC7900] tab and then on the [Halftones] icon in the opened window.

a. **Gamma control**

You can adjust the tone level of original photo images to obtain an optimum photo tone in prints. If you select "Gamma control-ON", the adjustment of the contrast and density of original photo images will be possible with the 5-step sliding bars. The adjustment result can be checked with the sample preview and the halftone (gamma) curve indication.

If you select "Use queue settings", the tone level of original photo images will be adjusted as specified in the selected queue of the SC7900.

b. **Screen type**

You can specify which screening mode should be applied in processing halftone images in document files, "ABS (Adobe Brilliant Screens)" or "Dot screen". If you select "Dot screen", you can also adjust the screen parameters, angle and frequency, here.

**Angle:**

The direction in which a screen is applied to halftone images. When you print screen-covered images doubly in different colors, it is recommended to make a more-than-15-degree difference between the applied screen angles. The available values are; 0, 15, 30, 45, 60 and 75 degrees. The default value is 45 degrees.

**Frequency:**

The fineness of a screen, which is indicated by the number of lines per inch (= 25.4mm). The available value range is between 38 and 200 lpi. The default value is 75 lpi.
Setting the Print Conditions

---

Adobe Brilliant Screens are:

"Adobe Brilliant Screens" are one type of frequency-modulated (FM) screening technologies, which changes the distance between the dots (their frequency) according to the halftone density. This results in finer details while maintaining sufficient levels of gray. Note that there is no screen parameter like screen frequency and angle for FM screening.

If you select "<Open/Queue>", the screen whose style is specified in the selected queue of the SC7900 will be applied in processing halftone images.
[SC7900] Tab-[Output] Window

NOTE   This window can be opened by clicking on the [Settings] button in the entry window of the [SC7900] tab and then on the [Output] icon in the opened window.

a. Print speed
   You can select the print speed of the RISO printer. Click on the [V] bar and select a desired speed level from the displayed list. 5 levels of print speed are available. If you select "<Open/Printer>", the RISO printer operates at the speed level as specified on its own control panel.
   When "<Open/Queue>" is selected, on the other hand, the print speed specified in the selected queue of the SC7900 will be applied. The factory-set speed level is "<Open/Printer>".

b. Print density
   You can select the print density of the respective colors which are available on the RISO printer. Click on the [V] bar and select a desired density level from the displayed list. 5 levels of print density are available for the respective colors. If you select "<Open/Printer>", the RISO printer prints at the density level as specified on its own control panel.
   When "<Open/Queue>" is selected, on the other hand, the print density specified in the selected queue of the SC7900 will be applied. The factory-set density level is "<Open/Printer>".

c. Confidential mode
   You can prevent your confidential documents from being duplicated without your knowledge by activating this option. Select "On" to activate it. When it is activated, the remaining master is automatically replaced with a blank one after all specified print jobs are finished. The factory-set status is "<Open/Queue>", in which the condition specified in the selected queue of the SC7900 will be applied.
d. **Process**

You can specify how to process your print jobs on your RISO printer, i.e. to complete them without interruption or to interrupt them after a specified process step. By interrupting your print jobs, you can check print position and quality with test prints before printing process or change the print job flow according to your print requirements. Click on the [▼] bar and select a desired process flow from the displayed list. The available process flows are as follows:

- **Full auto**: To complete print jobs without operator involvement on your RISO printer. No pause is made between master-making and printing processes until the end of print jobs.

- **Semi-auto (Master)**: To interrupt print jobs before each printing process, thus allowing you to check a sample print.

- **Semi-Auto (Print)**: To interrupt print jobs before each master-making process, thus allowing you to handle a stack of printed copies, especially for duplex printing.

- **Manual**: To interrupt print jobs before each process step, i.e. both master-making and printing processes.

The factory-set process flow is "<Open/Queue>", which lets the RISO printer process print jobs as specified in the selected queue of the SC7900.

e. **Proof copy output**

You can specify the number of proof copies to be provided after the master-making process, between "0" and "9". The factory-set number is "<Open/Queue>", by which the RISO printer prints the number of proof copies specified in the selected queue of the SC7900.

f. **Job separator**

You can activate the Job separator on your RISO printer and select the timing of separation tape insertion. Click on the [▼] bar and select a desired option from the displayed list. The separation tapes can be inserted "between pages" or "between documents". The factory-set option is "<Open/Queue>", which lets the Job separator operate as specified in the selected queue of the SC7900. If you do not want to use the Job separator, select "OFF".

g. **Reset before first Master**

The RISO printer is reset before receiving print data when "ON" is selected for this option. It is recommended to select "ON" in most cases. The factory-set status is "<Open/Queue>", which lets the RISO printer operate as specified in the selected queue of the SC7900.
[SC7900] Tab-[Forms] Window

This window can be opened by clicking on the [Settings] button in the entry window of the [SC7900] tab and then on the [Forms] icon in the opened window.

a. Merge form
   If you tick this option box, you can add the image data which are selected from the list box below on prints as the background of original images. We call the images to be placed on the background of printed sheets in this way "Forms" because this operation is much like printing on form sheets.

   NOTE You can also register desired background images to be selected from this list box. (See page #

b. Copy form to clipboard
   If you click on this button, the image data of the selected form are copied to the clipboard, thus allowing you to paste it as background graphics directly into the corresponding pages of documents to obtain their form-merged preview. As the form is scaled to the page size of the selected document, arrange the contents of documents accordingly. Always remove the pasted form before printing documents because its quality (resolution) is low.

c. Preview
   The preview of the selected form is shown in this frame.

This window can be opened by clicking on the [Settings] button in the entry window of the [SC7900] tab and then on the [Utility] icon in the opened window.

![SC7900 Utility Window]

a. Send e-mail messages

If you tick this option box, e-mail messages will be sent to a specified address at a specified time, informing of the current operation status of the SC7900. The e-mail address entry field is prepared on the right side of this section and two message delivery times are given as options as described below.

On job's end : Whenever the operation stops in the SC7900
On errors : Whenever an error occurs in the SC7900

b. Delegation

You can activate the "Job delegation" feature of the SC7900 by selecting "ON" here.

"Job delegation" is the feature which allows you to use multiple SC7900s to share print load among multiple RISO printers. There are two different ways of print load sharing available, i.e. range sharing and volume sharing.

In "range sharing", when the output page count is over a specified range, the excess output pages will be processed in another SC7900. In "volume sharing", on the other hand, when the print quantity is selected over a specified volume, the excess quantity will be printed through another SC7900.

c. Destination

You can select the destination of document data after they are processed in the selected queue of the SC7900. Click on the [V] bar and select a desired destination from the displayed list. The following destinations are prepared for your selection:
Setting the Print Conditions

**Printer**: Document data are to be output to the connected RISO printer to be printed out.

**Archive**: Document data are to be stored in the "Archive" queue in the SC7900 to allow you to view them on your computer as "feedback" image or to merge them each other. (See page ##.)

**Form**: Document data are to be stored in the "Form" queue in the SC7900 and will be available as form in the [Forms] window. (See page ##.)

**Open/Queue**: Document data are to be forwarded to the destination specified in the selected queue of the SC7900.
Creating a PS File

You can convert a desired document file into a PS (PostScript-format) file with the SC7900 printer driver instead of printing it on the RISO printer. You can also print out the PS files created here using the RISO Console II.

1. **Open a document file and specify the print job in the [Print] dialog box.**

   Select [Print] in the [File] menu to open the [Print] dialog box.

   ![Print dialog box image]

2. **Confirm that a SC7900 printer driver is selected in the [Printer] field in the [Print] dialog box.**

   Specify a name and a destination for the PS file to be created in the displayed dialog box and click on the [OK] or [Save] button.

   ![Print to file image]

   **NOTE** Make sure that normal queue is selected.
Output the document data to a file.

Select the corresponding check box, e.g. [Print to file], and click on the [OK] button. Then specify a name and a destination for the PS file to be created in the displayed dialog box and click on the [OK] or [Save] button.

**NOTE** If the corresponding check box does not exist in the [Print] dialog box, change the printer driver configuration. Open the [Properties] dialog box from the [Printers] folder and select "File" in the [Print to the following port] list in the [Details] or [Ports] tab. Then open the [Print] dialog box and click on the [OK] button. Then open the [Print] dialog box and click on the [OK] button.
Using Forms

Forms are the processed jobs (document files) whose image contents can be applied to other jobs as background images, e.g. company letterhead, in printing steps, thus saving you preparation of form sheets.

To Register Forms

Select the [SC7900] tab in the [Properties] dialog box of the corresponding printer driver and open the [Utility] window. Then specify "Form" as output destination and output the selected form to the SC7900 normal queue.

When the selected forms are registered in the SC7900, they appear in the list of forms in the RISO Console II and in the [Forms] window of the [SC7900] tab in the [Properties] dialog box of the corresponding printer driver.

To Apply Forms in Print Jobs

Open the [Forms] window of the [SC7900] tab in the [Properties] dialog box of the corresponding printer driver and tick the [Merge form] option box. Then select a desired form from the given list. If you click on the name of the desired form, its preview appears in the right-side frame.
To obtain a form-merged preview of documents, select a desired form from the list and click on the [Copy form to clipboard] button. Then paste the form as background graphics into the corresponding pages of documents. As the form is scaled to the page size of the selected document, arrange the contents of documents accordingly. Always remove the pasted form before printing documents because its quality (resolution) is low.
Printing from Macintosh

Sending and Printing Data ......................... 46
Setting the Print Conditions ....................... 50
[Page Setup] Dialog Box ............................... 50
[Print] Dialog Box .................................... 52
[Page Attributes] Card ............................... 57
[Watermark] Card ..................................... 59
[PostScript™ Options] Card ......................... 60
[SC7900 Layout] Card ................................ 62
[SC7900 Forms] Card ................................ 65
[SC7900 Utility] Card ................................. 66
[SC7900 Halftones] Card ............................. 67
[SC7900 Output] Card ................................. 68
[SC7900 Coloring (Colouring)] Card ............... 70
[Background Printing] Card ......................... 72
[Cover Page] Card .................................... 73
[Color Matching] Card ............................... 74
[Layout] Card ......................................... 75
[Error Handling] Card ............................... 76
[PostScript Settings] Card ......................... 77
[Printer Specific Options] Card .................... 79
Creating a PS File .................................. 80
Using Forms .......................................... 81
To Register Forms .................................. 81
To Apply Forms in Print Jobs ...................... 81
Follow the procedures given below to print out document data on the RISO printer through the SC7900.

If the dedicated printer driver program has not been installed in your Macintosh yet, request your Technical Administrator to install it first.

1. **Turn on the RISO printer and load paper.**
   
   Load paper whose size and feed direction match your document page setup.

2. **Turn on the SC7900 and your Macintosh, then start Mac OS.**

3. **Select the current printer to be used.**
   
   Select “AdobePS” in the [Chooser] dialog box in the Apple menu. Then select a SC7900 queue in the right-hand [PostScript Printer] selection box by highlighting it and close the [Chooser] dialog box.

   ![Chooser dialog box](image)

   **NOTE** Make sure the SC7900 and the RISO printer are turned ON before selecting the printer driver. If the SC7900 queue names do not appear in the right-hand box even when the SC7900 and the RISO printer are turned ON, however, check cable connection and communication setup. For details, refer to the Macintosh user's manuals.

4. **SC7900-direct**
   
   You can print out document data immediately after your Macintosh has sent them to the SC7900 because the SC7900 receives document data only when it is processing no other print job. When the SC7900 is processing a print job, therefore, your Macintosh will refrain from sending document data there until the SC7900 finishes processing the current print job.
NOTE > If the SC7900 doesn’t store the PS printer fonts which correspond to the fonts used in your document, the font data concerned are automatically downloaded into the memory of the SC7900 and kept there while printing your document.

= SC7900-hold =

You can send document data to the SC7900 without printing them out. The document data sent from your Macintosh is stored in a location, called “hold queue”, in the hard disk of the SC7900. To print out the document data stored there, activate the dedicated status monitoring and document management utility program, RISO Console II, and follow required steps. (See page 78.)

NOTE > The document data stored in the “hold queue” stay there for repeated output, form creation or document feedback. If required, you can also change the print conditions of the document data stored in the “hold queue”.

= SC7900-normal =

You can send document data to the SC7900 even while it is processing another print job. The document data sent from your Macintosh is temporarily stored in a location, called “normal queue”, in the hard disk of the SC7900, and will be printed out later after all preceding ones stored in the “normal queue”.

NOTE > The document data stored in the “Normal Queue” will be deleted after it is printed out.

4 Open the document file to be printed.

5 Specify the print condition in the [Page Setup] dialog box.

Click on [Page Setup] in the [File] menu to open the [Page Setup] dialog box. (See page 64.)

Define the setting and click on the [OK] button.
Specify the print job in the [Print] dialog box.

Click on [Print] in the [File] menu to open the [Print] dialog box. (See page 64.)

[Printer:]
Make sure that [Printer] is set to your selected SC7900 queue. If not, click on the list box and select it from the displayed list.

[Copies:]
Specify the number of copies to be printed within the following range: 1 to 999.

[Reverse Order]
If you tick this option box, pages will be printed in reverse order.

[Paper Source]
You can select the paper tray when the RISO printer is equipped with the Multi-tray paper feeder. Click on the [v] bar and select one of the following items from the displayed list.

<Open>:
Paper is fed from the tray selected on the control panel of the RISO printer.

Auto:
Paper is fed from the tray which is to be selected automatically according to the page format of original document data.

Standard tray / Feed tray 1 / Feed tray 2:
Paper is fed from the tray selected here.

**NOTE** The Standard tray may not be included in the candidates for auto selection depending on the configuration of the RISO printer.
If you want to set additional print conditions for the current print job;

Select another card name, like [SC7900 Output], in the index box in the [Print] dialog box to open a desired option card. (See page 64.)

Start printing.

Click on the [Print] button in the [Print] dialog box.

The READY/DATA indicator on the SC7900 starts flashing, indicating that data processing has started.

When data processing is completed, the PAGE STANDBY indicator lights and the RISO printer starts printing.

- If you select a "hold queue" as print destination, the processed document data stay in the SC7900 and are not printed out on the RISO printer even after the PAGE STANDBY indicator lights.

- You can check and control the current print job process directly from your personal computer with the dedicated status monitoring utility program, RISO Console II. (See page 96.)

= Using Desktop Printers =

You can also print your document data using the following SC7900 desktop printers.

SC7900_direct SC7900_hold SC7900_normal

Drag and drop your document file icon into a desired SC7900 desktop printer icon. The [Print] dialog box of the corresponding application software will then be opened.

NOTE: If a desired SC7900 desktop printer icon does not exist on your Macintosh desktop, request your Technical Administrator to create it.
Setting the Print Conditions

You can set various print conditions using the [Page Setup] dialog box and the [Print] dialog box.

In the [Print] dialog box, a series of originally-designed cards are prepared to enable you to select desired print conditions easily for print jobs with the SC7900, in addition to the regular cards, in which you can select the common print conditions for PostScript printers.

**NOTE**
- The items whose setting is supposed to be required in printing with the SC7900 as well are explained for the regular cards in the following pages.
- The options which are available in the regular Cards vary depending on the version of the Adobe PS printer driver.

**[Page Setup] Dialog Box**

To open this dialog box, select [Page Setup] from the [File] menu.

**[Page Attributes] Card (See page 57.)**
- Printer
- Paper
- Orientation
- Scale
- Booklet

**[Watermark] Card (See page 59.)**
- Watermark
- Foreground
- Save With Document
- [Edit] button
[PostScript™ Option] Card (See page 60.)

- Flip Horizontal
- Flip Vertical
- Invert Image
- Substitute Fonts
- Smooth Text
- Smooth Graphics
- Precision Bitmap
  - Alignment
- Unlimited
  - Downloadable Fonts

[Custom Page Default] Card
[Print] Dialog Box

To open this dialog box, select [Print] from the [File] menu.

[General] Card

[SC7900 Layout] Card (See page 62.)

- Use Queue settings
- Pattern
- Sorter control
- Stapler
- Rotated (Rotated 180°)
- Mirror binding
- Creep compensation
- Shift

[SC7900 Forms] Card (See page 65.)

- Merge form
- Copy form to clipboard
[SC7900 Utility] Card (See page 66.)

a. Send e-mail to
b. Delegation
c. Destination

[SC7900 Coloring (Colouring)] Card (See page 70.)

This card appears only when the twin-cylinder (-drum) printer is selected as connected output device.

a. Use Queue Settings
b. Use auto cylinder (drum) selection
c. Text/Line-art processing
d. Color (Colour) density level

[SC7900 Halftone] Card (See page 67.)

a. Gamma control
b. Screen type
[SC7900 Output] Card (See page 68.)

a. Print Speed
b. Print density
c. Confidential mode
d. Process
e. Proof copy output
f. Job separator
g. Reset before first Master
h. [Save Settings] button

[Background Printing] Card (See page 72.)

a. Print in
b. Print Time

[Cover Page] Card (See page 73.)

a. Print Cover Page
b. Cover Page Paper Source
[Color Matching] Card (See page 74.)

a. Print Color

[Layout] Card (See page 75.)

a. Pages per sheet
b. Layout direction
c. Border
d. Print on Both Sides

[Error Handling] Card (See page 76.)

a. If there is a PostScript error
[PostScript Settings] Card (See page 77.)

a. Destination
b. Format
c. PostScript Level
d. Data Format
e. Front Inclusion

[Printer Specific Options] Card (See page 79.)

a. Printer

You are required to confirm that the SC7900 queue name you selected in the [Chooser] dialog box is displayed here. If not, click on the list box and select it from the displayed list.

b. Paper

Changing the standard paper size setting

When using any standard size of paper other than that displayed, click on the [Paper] box to display a list of paper sizes and select a desired one by highlighting it. The factory-set paper size is "Letter" or "A4".

NOTE The dimensions and margins of the respective paper sizes are displayed by clicking on the left-hand image.

Registering custom paper sizes in the [Paper] list

If you want to use an irregular size of paper in your print job, you can add it to the [Paper] list as custom paper size. Select [Custom Page Default] in the index box and open the following card.
- Registration procedure -

1. Select a desired paper size from the paper size list box above to use it as basic data for a custom paper size to be registered.

2. Change the values in the [Paper Size] and [Margins] sections to meet the dimension of the custom paper size.

3. Enter a desired name for the custom paper size in the [Custom Page Name] box and click on the [Add] button.

The specified custom paper size will then be registered in the [Paper] list with the given name.

NOTE

- You can delete the custom paper size once registered from the [Paper] list. Select it from the paper size list box above in the [Custom Page Default] card and click on the [Remove] button.
- Units: You can select the unit of length between “cm” and “inch”.
- PPD Limits: Indicates the allowable value ranges of the respective items for custom paper sizes on your RISO printer.

c. Orientation

You can change the print orientation when printing a document.

Whether you feed paper in the standard way, short edge first or paper is fed, long edge first, i.e. when “XX-R” is selected as paper size, the page image is always printed on the sheet in the same direction as shown in the selected icon.

d. Scale

You can reduce or enlarge the page image in printing according to your needs. The available scale range is 25% to 400%. The factory-set value is 100%.

e. Booklet

Do not tick this option box because this option is not available with the SC7900 printer station. If you want to layout pages on a sheet to make booklets, use the options in the [SC7900 Layout] card.
Setting the Print Conditions

[Page Setup] Dialog Box -
[Watermark] Card

NOTE Another feature which can provide you with more extensive operations about image inlay is available in the [SC7900 Forms] card.

You can superimpose a desired image, which is called watermark, on the pages when printing your document by selecting it from the list box below. The location and appearance of the selected text-format watermark can be specified in the [Watermark Specifications] dialog box, which can be opened by clicking on the [Edit] button. In this dialog box, you can also create a new text-format watermark.

You can select the data format of watermarks and the pages on which the selected watermark is to be superimposed as described below.

Format

The following three types of data format can be selected from the given list: PICT, EPS and TEXT.

NOTE To register PICT- or EPS-format files as watermarks, the corresponding files or their alias are required to be placed in the [Watermark] folder in [Preference].

Pages

- None : No watermark is superimposed.
- First : The watermark will be printed only on the first page of a document.
- All : The watermark will be printed on all pages of a document.

a. Watermark

The current watermark of the selected data format is displayed in this box. If you want to select another watermark of the same data format, click on the [▲][▼] button in the box and select a desired one from the displayed list.

b. Foreground

The watermark will be printed over the text on the page if you tick this option box.

c. Save With Document

The current document data will be saved with the selected watermark superimposed on pages if you tick this option box.

d. [Edit] button

Opens the [Watermark Specification] dialog box, in which you can add new text-format watermarks and specify their design.
[Page Setup] Dialog Box -

[PostScript™ Options] Card

- Visual Effects -

a. Flip Horizontal
   You can print your documents in mirrored images by activating this option.
   To activate it, select this box.

b. Flip Vertical
   You can print your documents upside down by activating this option.
   To activate it, select this box.

c. Invert Image
   You can print your documents in negative images by activating this option.
   To activate it, select this box.

- Image & Text -

d. Substitute Fonts
   The PS printer fonts stored in the SC7900 are used in place of several screen fonts in your document in printing as described below;
   “Times” for “New York”, “Helvetica” for “Geneva” and “Courier” for “Monaco”.
   With this option active, printing time can be reduced but unexpected print results may appear on printed copies due to the use of non-matching printer fonts.

e. Smooth Text
   You can smooth the jagged outline of downloaded bitmap fonts in printing.

f. Smooth Graphics
   You can smooth the jagged edges of bitmap graphic images in printing.
g. **Precision Bitmap Alignment**

You can prevent the quality deterioration of the bitmap images created on your Macintosh in printing due to incomplete resolution adjustment.

With this option active, however, the bitmap images concerned are reduced by certain degrees.

h. **Unlimited Downloadable Fonts**

If the SC7900 doesn’t store the PS printer fonts which correspond to the fonts used in your document, the font data concerned are automatically downloaded into the memory of the SC7900 and kept there while printing your document. If the memory is filled with the font data, however, no more font data can be downloaded there.

If this option is active, on the other hand, you can download as much font data as required while printing your document because the downloaded font data are not kept long in the memory and overwritten by the following ones.

If you have problems in printing a document with various kinds of fonts, therefore, select this option.

If this option is selected, however, it requires more printing time and may produce printing errors in certain application softwares.
[Print] Dialog Box -
[SC7900 Layout] Card

a. Use queue settings
If you use the layout design specified in the selected queue of the SC7900 in a print job, tick this option box. When this option is selected, no setting is possible in this window.

b. Pattern
You can select how to arrange pages on a sheet from the given list. The selected layout pattern image is given in the frame below.

Simplex: A single page is arranged on a sheet.

Duplex - Long edge/Short edge:
A single odd or even page is arranged on a sheet, given the binding margin on the long or short edge of the sheet. To arrange odd pages, select “Front” above the image frame and “Back” for even pages.

Duplex - Half-size booklet/Full-size booklet:
Two pages are arranged on a sheet, reducing page sizes to half or keeping original page sizes, to allow you to make half-page-size or full-page-size center-folded booklets. Different page arrangements are provided by changing the printed sheet side selection above the image frame, “Front” or “Back”.

NOTE When you select “Duplex - Full-size booklet”, make sure that the paper whose size is twice as large as of document page is loaded on the RISO printer.

c. Sorter control
You can select an operation mode of the optional sorter which is connected to the RISO printer. Click on the ▼ bar and select a desired one from the displayed list. The factory-set mode is “<Open/Queue>”. The modes which can be selected are as listed below.
Setting the Print Conditions

<Open/Queue>:
The connected sorter operates as specified in the selected queue of the SC7900.

NonSort:
Printed sheets are delivered into the Nonsort tray as if no sorter was installed, thus enabling you to process a large-volume print job speedily.

Sort:
Printed sheets are sorted in order to produce a desired number of copies of a multiple-page document.

Group:
Printed sheets are distributed into different groups of bins for different document pages. This mode may not be available with certain models of sorters.

Stack:
Printed sheets are distributed into a series of separate bins repeatedly, thus enabling you to secure ink-smudge-free prints.

d. Stapler
You can activate the stapler built in the sorter which is connected to the RISO printer and select the stapling position. Click on the [▼] bar and select a desired option from the displayed list. The given stapling positions are; “at upper left corner”, “at 2 points in the head” and “at 2 points along the side”. The factory-set option is “<Open/Queue>”, which lets the built-in stapler operate as specified in the selected queue of the SC7900. If you do not want to use the stapler, select “OFF”.

e. Rotated (Rotate 180°)
You can rotate print images by 180 degrees by activating this option with a tick in the option box. This option is useful when the page direction is required to be changed for stapling printed copies or printing on the media whose feeding direction is limited to one way, such as envelopes.

f. Mirror binding
You can change the assignment side of binding margins or the booklet page arrangement pattern, supposing that printed sheets are bound on the right side of page, by activating this option with a tick in the option box. The layout pattern image provided in the left-hand frame is also changed accordingly.

g. Creep compensation
You can shift images on document pages to compensate for the alignment shift (creep) in a stack of center-folded sheets which are bound to make a booklet, by entering a desired per-sheet compensation range. The available range is between 0μm and 2000μm.
<Creep compensation is:>

If you bind a stack of center-folded sheets to make a booklet, the side edges of pages do not align due to the thickness of stacked sheets. In normal procedure of booklet making, therefore, the side page edges are trimmed up, based on the cover page. In this case, however, images will be positioned out of line among the pages of the bound booklet. To prevent this resultant alignment shift, i.e. “creep”, in booklet pages, it is normal to shift images toward the binding center of a sheet before printing operation while changing the shift range by page depending on the sheet order in the stack. This special adjustment in making booklets of center-folded sheets is called “creep compensation”.

To find the shift range value for the respective pages in the creep compensation, first make a temporary booklet using the same number of sheets as required for the final booklet and trim up the side edges of pages. Make sure to use the same quality of paper as to be used in making booklets finally. Then measure the difference of length in the long edges of sheets between the covering one and the innermost one. If you divide this difference value by the number of sheets, you can get the creep compensation value.

h. Shift

You can shift images vertically and/or horizontally on pages while keeping the shift range constant in all pages, by entering a desired shift range into the respective boxes. The available range is between -20000μm and +20000μm.

You can use this option in addition to the print position adjustment on the RISO printer.
[Print] Dialog Box -
[SC7900 Forms] Card

*a. Merge form*

If you tick this option box, you can add the image data which are selected from the list box below on prints as the background of original images. We call the images to be placed on the background of printed sheets in this way "forms" because this operation is much like printing on form sheets.

**NOTE**
You can also register desired background images to be selected from this list box. (See page ##.)

*b. Copy form to clipboard*

When you click on this button, the preview of the selected form is shown in the frame below.
[Print] Dialog Box - [SC7900 Utility] Card

a. Send e-mail to
If you tick this option box, e-mail messages will be sent to a specified address at a specified time, informing of the current operation status of the SC7900. The e-mail address entry field is prepared on the right and two message delivery times are given as options as described below.

On job’s end: Whenever the operation stops in the SC7900
On errors: Whenever an error occurs in the SC7900

b. Delegation
You can activate the “Job delegation” feature of the SC7900 by selecting “ON” here.

“Job delegation” is the feature which allows you to use multiple SC7900s to share print load among multiple RISO printers. There are two different ways of print load sharing available, i.e. range sharing and volume sharing.

In “range sharing”, when the output page count is over a specified range, the excess output pages will be processed in another SC7900. In “volume sharing”, on the other hand, when the print quantity is selected over a specified volume, the excess quantity will be printed through another SC7900.

c. Destination
You can select the destination of document data after they are processed in the selected queue of the SC7900. Click on the [V] bar and select a desired destination from the displayed list. The following destinations are prepared for your selection:

Printer: Document data are to be output to the connected RISO printer to be printed out.

Archive: Document data are to be stored in the “Archive” queue in the SC7900 to allow you to view them on your computer as “feedback” image or to merge them each other. (See page #.)

Form: Document data are to be stored in the “Form” queue in the SC7900 and will be available as form in the [Forms] window. (See page #.)

<Open/Queue>: Document data are to be forwarded to the destination specified in the selected queue of the SC7900.
[Print] Dialog Box -
[SC7900 Halftones] Card

a. **Gamma control**
   You can adjust the tone level of original photo images to obtain an optimum photo tone in prints. If you select “Gamma control-ON”, the adjustment of the contrast and density of original photo images will be possible with the 5-step sliding bars. The adjustment result can be checked with the sample preview and the halftone (gamma) curve indication.

   If you select “Use queue settings”, the tone level of original photo images will be adjusted as specified in the selected queue of the SC7900.

b. **Screen type**
   You can specify which screening mode should be applied in processing halftone images in document files, “ABS (Adobe Brilliant Screens)” or “Dot screen”. If you select “Dot screen”, you can also adjust the screen parameters, angle and frequency, here.

   **Angle:** The direction in which a screen is applied to halftone images. When you print screen-covered images doubly in different colors, it is recommended to make a more-than-15-degree difference between the applied screen angles. The available values are; 0, 15, 30, 45, 60 and 75 degrees. The default value is 45 degrees.

   **Frequency:** The fineness of a screen, which is indicated by the number of lines per inch (= 25.4mm). The available value range is between 38 and 200 lpi. The default value is 75 lpi.

---

**Adobe Brilliant Screens are:**

“Adobe Brilliant Screens” are one type of frequency-modulated (FM) screening technologies, which changes the distance between the dots (their frequency) according to the halftone density. This results in finer details while maintaining sufficient levels of gray. Note that there is no screen parameter like screen frequency and angle for FM screening.

---

If you select “<Open/Queue>”, the screen whose style is specified in the selected queue of the SC7900 will be applied in processing halftone images.
[Print] Dialog Box - [SC7900 Output] Card

a. Print speed
You can select the print speed of the RISO printer. Click on the [V] bar and select a desired speed level from the displayed list. 5 levels of print speed are available. If you select "<Open/Printer>", the RISO printer operates at the speed level as specified on its own control panel.

When "<Open/Queue>" is selected, on the other hand, the print speed specified in the selected queue of the SC7900 will be applied. The factory-set speed level is "<Open/Printer>".

b. Print density
You can select the print density of the respective colors which are available on the RISO printer. Click on the [V] bar and select a desired density level from the displayed list. 5 levels of print density are available for the respective colors. If you select "<Open/Printer>", the RISO printer prints at the density level as specified on its own control panel.

When "<Open/Queue>" is selected, on the other hand, the print density specified in the selected queue of the SC7900 will be applied. The factory-set density level is "<Open/Printer>".

c. Confidential mode
You can prevent your confidential documents from being duplicated without your knowledge by activating this option. Select "On" to activate it. When it is activated, the remaining master is automatically replaced with a blank one after all specified print jobs are finished. The factory-set status is "<Open/Queue>", in which the condition specified in the selected queue of the SC7900 will be applied.
d. Process
You can specify how to process your print jobs on your RISO printer, i.e. to complete them without interruption or to interrupt them after a specified process step. By interrupting your print jobs, you can check print position and quality with test prints before printing process or change the print job flow according to your print requirements. Click on the [V] bar and select a desired process flow from the displayed list. The available process flows are as follows:

Full auto: To complete print jobs without operator involvement on your RISO printer. No pause is made between master-making and printing processes until the end of print jobs.

Semi-auto (Master): To interrupt print jobs before each printing process, thus allowing you to check a sample print.

Semi-Auto (Print): To interrupt print jobs before each master-making process, thus allowing you to handle a stack of printed copies, especially for duplex printing.

Manual: To interrupt print jobs before each process step, i.e. both master-making and printing processes.

The factory-set process flow is "<Open/Queue>", which lets the RISO printer process print jobs as specified in the selected queue of the SC7900.

e. Proof copy output
You can specify the number of proof copies to be provided after the master-making process, between "0" and "9". The factory-set number is "<Open/Queue>", by which the RISO printer prints the number of proof copies specified in the selected queue of the SC7900.

f. Job separator
You can activate the Job separator on your RISO printer and select the timing of separation tape insertion. Click on the [V] bar and select a desired option from the displayed list. The separation tapes can be inserted "between pages" or "between documents". The factory-set option is "<Open/Queue>", which lets the Job separator operate as specified in the selected queue of the SC7900. If you do not want to use the Job separator, select "OFF".

g. Reset before first Master
The RISO printer is reset before receiving print data when "ON" is selected for this option. It is recommended to select "ON" in most cases. The factory-set status is "<Open/Queue>", which lets the RISO printer operate as specified in the selected queue of the SC7900.

h. [Save Settings] button
Customizes the factory-set (default) settings.

If you click on this button, the current settings are saved as default ones and will appear whenever you open this dialog box until you change them and click on this button again.
[Print] Dialog Box -
[SC7900 Coloring (Colouring)] Card

NOTE
This card appears only when the twin-cylinder (-drum) printer is selected as connected output device.

In this card, you can easily specify how to process color document data to be printed out on the twin-cylinder (-drum) printer, given the 2-step cylinder (drum) selection boxes for controlling the process flow and the sample image previews as selection guidance.

If you want to print in a single color:

Tick the selection boxes of a desired color cylinder (drum) while clearing the counterparts of the other one. Only the sample image previews of the selected color then remain in the window.

If you want to print in two different colors:

Tick all selection boxes of both color cylinder (drum) and select desired color elements separately for text/line art and photo images in the respective option fields in the relative sections. The sample previews of selected color-element images which are to be printed in the given colors are shown in the window.

Special application in dual-color printing:

You can make dual-color prints while selecting a single print color for the current document file on your computer. Tick the selection boxes of a desired color cylinder (drum) for the current document file while clearing only the primary selection box of the other one. The current document file is then printed in the selected color, adding the images prepared on the other color cylinder (drum) in advance. This special application is recommended when you print different contents on the same form.
Setting the Print Conditions

=Quick color separation...=

In preparation of coloring process in this window, original color image data are processed based on 4 color-element data, i.e. Red, Green, Blue and Black. When you select one or several color elements of text/line art or photo images for a given color cylinder (drum), the images which contain the selected color element(s) at a high percentage are collected and processed to be printed in the given color.

a. Use Queue Settings

If you use the coloring design specified in the selected queue of the SC7900 in a print job, tick this option box. When this option is selected, no setting is possible in this window.

b. Use auto cylinder (drum) selection

If you tick this option box, it is automatically decided based on the color data of the installed print cylinders (drums) what original color image should be printed in which color (red or another) on dual-color prints.

c. Text/Line-art processing

You can select either of the following two styles in printing out colored or gray texts/line-art images in your document data.

To Halftones: The color difference of texts and line-art images can be reproduced as tone difference on prints. In dual-color printing, 70% halftone-level images, which correspond to red in color, will be reproduced as solid on prints when printed in "Color (Colour) 1", as standard configuration of RISO printers.

To Solid look: The color difference of texts and line-art images is not reflected on prints and all images are to be reproduced as solid ones there.

d. Color (Colour) density level

You can adjust the contents level of a selected color element in processed image data by shifting the pointer on the sliding bar. If you shift the pointer toward "100%", the contents of the selected color element will be increased, thus causing the image tone darker.
a. Print in

You can turn off and on the Background printing feature. If the Background printing feature is selected, you can work on another document while printing a document.

NOTE Always selected the Foreground printing feature when you use the [SC7900 direct as the current printer Otherwise, the font data will not be automatically downloaded into the memory of the SC7900 in each print job. (See page 44.)

b. Print Time

You can specify when your document should be printed as follows:

- Urgent: Before all print jobs currently waiting in a Queue
- Normal: After all print jobs currently waiting in a Queue
- Print at: At the time and date specified here
- Put Document on Hold: Your document data is kept in a print queue without being printed.
[Print] Dialog Box - [Cover Page] Card

a. Print Cover Page
   You can print an additional cover sheet before or after printing your document. The current document file name, current time and date, printer name and so on, are given there.

b. Cover Page Paper Source
   You can select the paper tray for the cover page when the RISO printer is equipped with the Multi-tray paper feeder.
a. Print Color

You can specify the image processing pattern to be used for photo or color document between: Color/Grayscale or Black&White.

If you select "Color/Grayscale", different shades are available for colored or gray images.

If you select "Black&White", on the other hand, colored or gray images are processed in black & white.

The factory-set pattern is "Color/Grayscale".

"Colorsync Color Matching" and "PostScript Color Matching" have no effect on printed copies with the SC7900.
[Print] Dialog Box - [Layout] Card

a. Pages per sheet  You can specify the number of pages to be printed on one piece of paper for multiple-page documents from: 1, 2, 4, 6, 9 or 16 pages.

b. Layout direction  You can specify how multiple pages should be arranged on a sheet.

c. Border  You can add border lines between the pages to be printed on a sheet.
The following four kinds of lines are available: single hair line, single thin line, double hair line and double thin line.

d. Print on Both Sides  Do not tick this option box because this option is not available with the SC7900 printer station.
a. If there is a PostScript™ error

You can specify how a PostScript error should be reported if it occurs, “Summarize on screen” or “Print detailed report”.

If “No special reporting” is selected, however, a PostScript error is not reported. The factory-set status is “No special reporting”.
a. Destination

You can save the print data in a file, named “Print Data”, by selecting “File” in this option.

Click on the list box and highlight “File” in the displayed list to select it.

The “Print Data” file is stored in the [Extensions] folder.

The factory-set status is “Printer”.

b. Format

You can select a file format for the “Print Data” file among the following:

- **PostScript Job**
  A standard PostScript file format.

- **EPS Mac Standard Preview (only for a single-page file)**
  An Encapsulated PostScript file format with a standard 72-bit preview image for displaying the page on the Macintosh screen.

- **EPS Mac Enhanced Preview (only for a single-page file)**
  An Encapsulated PostScript file format with a QuickDraw PICT preview image.
  A PICT preview image can be scaled accurately to display in different sizes when the EPS file is placed within other Macintosh applications.

- **EPS No Preview (only for a single-page file)**
  An Encapsulated PostScript file format without a preview image; this reduces the size of the EPS file. When the file is placed within an application, the file cannot be displayed on the screen, but it can be printed.
c. **PostScript Level**

You can specify which type of PostScript codes should be applied to create PostScript or EPS files, “Level 1, 2 and 3 Compatible”, “Level 2 Only” or “Level 3 Only”.

If “Level 1, 2 and 3 Compatible” is selected, the created files can be printed on a PostScript Level 1 and/or 2 printer as well.

If “Level 2 Only” is selected, they can only be printed on a PostScript Level 2 printer.

If “Level 3 Only” is selected, they can only be printed on a PostScript Level 3 printer, such as the SC7900.

d. **Data Format**

You can specify which data format should be used to save PostScript or EPS files to be created, “ASCII” (Text) or “Binary”.

“Binary” files are typically smaller in size than “ASCII” ones.

e. **Font Inclusion**

You can specify what font data should be included in PostScript or EPS files to be created, from the following:

- **None**: No font data included.
- **All**: All font data included.
- **All But Standard 13**:
  
  All font data included, excluding the standard 13 fonts which are available in most PostScript printers.

- **All But Fonts in PPD file**:
  
  All font data included, excluding the fonts which are listed in the PPD file of the current printer.
You can specify the operation conditions of the RISO printer here, which can be specified in the [SC7900...] cards as well. Though it is convenient to have the list of all RISO printer features whose setting can be selected for print jobs, it is recommended to use the [SC7900...] cards to specify the operation condition of the RISO printer because the [SC7900...] cards are specially designed to allow you to specify the operation condition of the SC7900 printer station with easy steps according to your print job requirements.

If you specify the operation conditions of the RISO printer here, they will be used in the current print job regardless of the settings of the corresponding items given in the [SC7900...] cards.

NOTE: This card will not be available if the [SC7900...] cards are selected as unique reference source of the operation conditions of the selected RISO printer in the [SC7900 Plug-In] option of the corresponding PPD file. If you want to use this card, in this case, contact your SC technical administrator and request to change the current printer diver configuration.
You can convert a desired document file into a PS (PostScript-format) file with the SC7900 printer driver instead of printing it on the RISO printer. You can also print out the PS files created here using the RISO Console II.

1. **Change the destination in the (Print) dialog box.**
   Open the [Print] dialog box and select “File” in the [Destination] box.

2. **Specify the PostScript output format.**

   The selected document file will be named “Print Data” and saved in the [Extensions] folder.
Using Forms

Forms are the processed jobs (document files) whose image contents can be applied to other jobs as background images, e.g. company letterhead, in printing steps, thus saving you preparation of form sheets.

To Register Forms

Select the [SC7900 Utility] card in the [Print] dialog box of the corresponding printer driver. Then specify “Form” as output destination and output the selected form to the SC7900 normal queue.

When the selected forms are registered in the SC7900, they appear in the list of forms in the RISO Console II and in the [SC7900 Forms] card in the [Print] dialog box of the corresponding printer driver.

To Apply Forms in Print Jobs

Open the [SC7900 Forms] card in the [Print] dialog box of the corresponding printer driver and tick the [Print form] option box. Then select a desired form from the given list. If you click on the [Show preview of form] button, its preview appears in the right-side frame.
Using the RISO Console II

RISO Console II Overview ......................... 84
Viewing Properties - SC7900/
  Queue/Job ........................................ 85
Navigation Guide in the Main View Window ...... 85
[RISO Console II - SC7900 Details] Dialog Box .... 86
[RISO Console II - Queue Details] Dialog Box ..... 88
[RISO Console II - Job Details] Dialog Box ..... 89
Monitoring the SC7900 Communication
  Status ............................................. 91
Monitoring the Current Status of
  RISO Printers .................................... 92
Managing Jobs (Processed Documents) .... 95
Exporting Processed Document Data for
  Preview (Job Feedback) ....................... 97
Merging Document Files ......................... 99
  File Merge Options ............................ 99
Printing PostScript / PDF Files ............. 101
  Printing Procedure ......................... 101
Viewing the List of Installed Fonts .......... 102
Extending the Search Range for
  SC7900 ......................................... 103
Changing the RISO Console II
  Properties ..................................... 104
The dedicated SC7900 utility program, RISO Console II, allows you to monitor the current status of multiple SC7900 print stations, including the structure and configuration of queues, and manage the documents stored in the SC7900s under the unique queue structure over the network.

You can use the RISO Console II under two different status, i.e. user or administrator. As a user, you can use the RISO Console II to submit and monitor jobs, edit the job ticket, and perform special actions like merging files, scanning and feedback. As an administrator, on the other hand, you can also configure SC7900s for such operations as job delegation, create multiple queues to provide different printing profiles, and collect account data, while keeping the user’s status. The operations which are possible under the respective status are listed below.

**NOTE** To obtain the administrator status, you are required to select [Administrator login] in the Tools menu and enter the administrator password in the displayed dialog box. Only one operator can be the administrator for a single SC7900 at a time.

== Possible operations under a user’s status ==

- To view the properties of SC7900s, queues or jobs (→ P.##)
- To monitor the current status of RISO printers (→ P.##)
- To change /copy /delete one’s own jobs (→ P.##)
- To copy /view jobs owned by other users (this may be restricted by the administrator) (→ P.##)
- To register forms (→ P.##)
- To export processed document data for preview (→ P.##)
- To merge document files (→ P.##)
- To print PostScript/PDF files (→ P.##)
- To view the list of installed fonts (→ P.##)
- To extend the search range for SC7900s (→ P.##)
- To change the RISO Console II properties (→ P.##)
- To scan images (→ P.##)

== Possible operations only under the administrator’s status ==

- To change the SC7900 configuration
- To use the Quick DHCP server of the SC7900
- To design the queue structure in the SC7900
- To configure the job delegation feature
- To change jobs owned by other users, including assigning another owner
- To view job account data
- To customise the font configuration in the SC7900
- To restart or shut down the SC7900

**NOTE** For detailed descriptions about the operations which are possible only under the administrator’s status, refer to another booklet provided, i.e. Technical Administrator’s Guide.
Viewing Properties - SC7900/Queue/Job

When you activate the RISO Console II, the main view window appears to provide you with different levels of information about the SC7900, queue or job properties in such forms as overview, list and details.

The left-side column of the main view window shows a navigation overview tree of SC7900s and queues in the network, while the right-side frame shows the list of the subordinate items stored in a main item selected in the left-side column, i.e. SC7900s, queues or jobs. The detailed dialog boxes, besides, allow you to check the properties of the selected SC7900s, queues, or jobs, depending on your access rights.

The RISO Console II monitors all listed items all the time. The status display of SC7900s, queues, and jobs in the main view window is regularly updated to reflect their changes without extra burdens on network traffic.

=To activate the RISO Console II, follow the procedures below=


NOTE The RISO Console II is not available when the SC7900 is connected to your computer via a local printer port only.

Navigation Guide in the Main View Window

You can explore the subordinate items which are included in the respective main ones by clicking on the [+] marks (on Windows) or triangular marks (on Macintosh) in the guide view. When an item is selected in the guide view, besides, its contents are displayed in the right-side frame, i.e. SC7900s to [Network], queues to [SC7900] and jobs to [Queue].

To view the detailed information of an item in the right-side frame, highlight a desired item with a click and select [Details] from the File menu.
To enhance the usability of SC7900s, the following special queues are listed in the guide view under the respective SC7900 names. They are only available in this guide view and their configurations can only be changed by the administrator.

- **Active jobs:** Contains jobs under processing.
- **Finished jobs:** Contains jobs which have been processed.
- **Archive:** Contains the bitmap image data of documents for feedback or preview.
- **Forms:** Contains the forms which can be applied in print jobs.
- **Scan:** Contains the scanned image data which can be pasted in document pages.

The following icons are also used for queues in the guide view to help you identify the queue type.

- ![ ] - Indicates the current queue type is “normal queue”. One “normal queue” is prepared under the name “Normal” as default.
- ![ ] - Indicates the current queue type is “hold queue”. One “hold queue” is prepared under the name “Hold” as default.

**NOTE** Custom “normal queues” and/or “hold queues” may be added, given other names, in the guide view by the administrator.

---

**[RISO Console II - SC7900 Details] Dialog Box**

The detailed information about the selected SC7900 properties can be viewed in this dialog box, which can be opened by selecting [Details] from the File menu after highlighting the selected SC7900 in the guide view.

**[General Info] Tab**

- **Installed memory:** The volume of the memory installed in the SC7900 (MB)
- **Version:** The version number of the SC7900 system
- **Serial number:** The serial number of the SC7900 unit
- **Administrator mode:** “ON” is displayed when you open this dialog box as administrator.
- **SC7900 time adjustment:** The time and date provided by the SC7900 system clock
- **SC7900 status:** The current operation status of the SC7900, which is also displayed in the list of the main view window.
- **Free access:** If “No” is displayed, other users than owners cannot view the job properties.
- **Comment:** The description in this box is displayed in the [Comment] column in the list of the main view window.
- **Pages to print:** The total print quantity to be produced from the print jobs in the “Active jobs” queue, which is also displayed in the list of the main view window.
- **Job count:** The total number of print jobs in the “Active jobs” queue, which is also displayed in the list of the main view window.
[Communication] Tab

- Name (.domain) : The SC7900 name displayed in the RISO Console II as printer name
- Use DHCP : If "ON" is displayed, the DHCP server will be used to assign an IP address to the SC7900 whenever the power is turned on.

**NOTE** The remaining items are the parameters required for network communication, of which the IP address is also displayed in the list of the main view window.

[Output device] Tab

Provides the information about the connected RISO printer

- Resolution : The printing resolution
- Output device status : The current status (busy or idle)
- Mode : The current operation condition
- Warning : The low volume warning messages are displayed here for consumables.
- Error : The detailed status is displayed here when an error occurs.
- Vendor : The vendor name
- Name : The model name
- Revision : The system interface version
- Print density control capability : Indicates if the print density can be adjusted
- Print density : The current print density level
- Print speed : The current print speed level
- Cylinder (Drum) size : The size of the installed print cylinder (drum)
- Print color (colour) : The available print color
- Color (Colour) : The color code of the installed print cylinder (drum)
- Master disposal quantity : The quantity of used masters in the master disposal box
- Scanning capability : Indicates if images can be scanned in.
- Duo mode capability : Indicates if the duo mode is available in scanning images.
- ADF scanning availability : Indicates if the ADF unit is available in scanning images.

[Paper] Tab

Provides the information about the paper feed trays of the connected RISO printer.

- Paper size : The size of loaded paper
- Paper quantity : The percentage of the capacity occupied with paper
- Paper type : The type of loaded paper

[Finisher] Tab

- Sorter : Indicates if the optional sorter is installed on the connected RISO printer.
- Stapler : Indicates if the online stapler is available with the installed sorter.
- Job separator : Indicates if the Job separator is installed on the connected RISO printer.
[RISO Console II - Queue Details] Dialog Box

The detailed information about the selected queue properties can be viewed in this dialog box, which can be opened by selecting [Details] from the File menu after highlighting the selected queue in the guide view.

[General Info] Tab

- Queue name: The name of the selected queue
- Status: The type of the selected queue
- Network entry: Indicates if the selected queue appears as network printer in the [Print] dialog box. If not, you cannot output document data to it in print jobs.
- Priority: The order in which the print jobs in the selected queue are processed on the RISO printer. When there are several queues which contains the print jobs waiting to be processed on the RISO printer, the jobs in the queue whose priority is “high” will be processed earlier.
- Comment: The description in this box is displayed in the [Comment] column in the list of the main view window.
- Job size limit: The maximum print volume which is acceptable to the selected queue. The print job whose queue entry has been rejected will be stored in the default normal queue.
- Total output pages in queue: The total print quantity to be produced from the print jobs in the selected queue, which is also displayed in the list of the main view window.
- Jobs in queue: The total number of jobs stored in the selected queue, which is also displayed in the list of the main view window.

NOTE > The following items are not displayed for the “hold queue”: “Priority”, “Job size limit” and “Total output pages in queue”.

[Print Conditions] Tab

Provides the information about the print conditions specified in the selected queue. The print conditions specified here are applied to the jobs stored in this queue if “Use queue settings” is selected as reference source. If “Use original settings” is selected here, on the other hand, the original print conditions specified when you output the corresponding document data to the selected queue are applied in print jobs regardless of the settings in this queue. Refer to the pages describing the print conditions which can be specified in normal print jobs for detailed descriptions about the items listed in this tab.

NOTE >
- The reference source can be different depending on the items of print conditions.
- This tab appears only for the “normal queue”.

88 User’s
= Relationship guidance =


Print speed / Print density / Confidential mode / Process flow / Proof copies / Job separator


Coloring design / Coloring mode / Text/line-art coloring design / Text/line-art processing / Color density level → [Properties] - [SC7900] - [Coloring] (on Windows) / [Print] - [SC7900 Coloring] (on Macintosh)

[RISO Console II - Job Details] Dialog Box

The detailed information about the selected job properties can be viewed in this dialog box, which can be opened by selecting [Details] from the File menu after highlighting the selected job in the guide view.

You can also change several items of print conditions you have specified in the selected job in this dialog box. A pop-up option menu box is prepared for the items whose setting can be changed.

**NOTE**

- To view the properties of the jobs owned by another user, a free access is required to be opened to jobs in the corresponding SC7900. For details, consult your SC7900 administrator.
- The operation of changing the print conditions of jobs in the RISO Console II is limited to the job owner and your SC7900 administrator.
[General Info] Tab

- Status : The queue in which the selected job is stored, which is also displayed in the list of the main view window.
- Data source : The route through which the document data of the selected job have been received, e.g. TCP/IP and NetBIOS, which is also displayed in the list of the main view window.
- Job name : The name of the selected job, which is also displayed in the list of the main view window.
- Owner name : The login name of the computer from which the document data of the selected job have been sent, which is also displayed in the list of the main view window.
- Host name : The listed name of the computer from which the document data of the selected job have been sent
- Queue name : The name of the queue in which the selected job is stored
- Comment : The description in this box is displayed in the [Comment] column in the list of the main view window.
- Document pages : The number of pages the document data of the selected job contain, which is also displayed in the list of the main view window.
- Copy count : The print quantity specified in the selected job
- Paper size : The paper size specified in the selected job

[Print conditions] Tab

Provides the information about the print conditions specified in the selected job. Refer to the pages describing the print conditions which can be specified in normal print jobs for detailed descriptions about the items listed in this tab, consulting the relationship guidance above.

[Logging] Tab

Shows a series of actions (events) taken on the selected job. The logged actions/events are : Download/create/copy jobs, start/end SC7900, start/end printing, reassign jobs for sharing and errors. In certain cases, additional information about the events is also provided, e.g. another SC7900 sharing jobs or causes of errors.
Monitoring the SC7900 Communication Status

You can check the communication status of all SC7900 units that are connected to your network in the following window (which is to be opened first when the RISO Console II is activated). When no communication exchange exists in a SC7900 unit, "idle" is displayed in the [State] column in the list. In this case, you can use this SC7900 for your print job without delay.
Monitoring the Current Status of RISO Printers

You can check the current status of all RISO printer stations on the network on your computer, using the illustrated monitoring window, which can be opened by selecting [Monitoring view] from the Tools menu.

The status information displayed in this window is automatically updated at a specified interval.

**NOTE** All status information is indicated by icons, whose text descriptions will appear in the thumbnail to be displayed by placing a cursor on them.

<table>
<thead>
<tr>
<th>Name</th>
<th>Consumables</th>
<th>Errors</th>
</tr>
</thead>
</table>

The names of the connected SC7900 printer stations are indicated in this column. The current status of the SC7900 printer stations are also shown with the following icons:

- The SC7900 is idle and ready to receive data.
- The SC7900 is recovering the initial setting.
- The SC7900 is waiting for your instruction. Give an instruction to the SC7900 with key operation. — See page 11.
- The SC7900 is processing printing data.
- The RISO printer is idle and ready to operate.
- The RISO printer is in Energy Saving mode.
- The SC7900 is processing scanned data from the RISOGRAPH.
- The SC7900 is out of operation due to internal system error.
- The SC7900 is not available now. Wait until it becomes available.
- The RISO printer is scanning a document.
- The RISO printer is operating in the confidential mode.
Monitoring the Current Status of RISO Printers

The RISO printer is out of operation. Check the icon indication in other columns.

The RISO printer is operating off-line. Wait until the off-line operation finishes.

The RISO printer is not found. Check power or cable connection of the RISO printer.

The RISO printer is out of operation due to error in TM2500.

The RISO printer is making a master.

The RISO printer is out of operation due to error in TM5000.

The RISO printer is printing documents.

b. Consumables

The following icons appear in this column when the RISO printer cannot operate due to the status change of consumables.

- Ink has been used up. Replace an ink cartridge.
- Master has run out. Replace a master roll.
- No printing paper remains. Add paper.
- The Master disposal box has become full. Empty it.
- The stapler has run out of staples in TM5000. Replace the staple cartridge.
c. Errors

The following icons appear in this column when the RISO printer cannot operate due to errors or incomplete setup.

- A serious trouble has occurred. Contact your service representative.
- Paper jam has occurred. Remove the jammed paper.
- Master jam has occurred. Remove the jammed master.
- Original jam has occurred in ADF scanning. Remove the jammed original.
- The RISO printer is waiting for the operation to be resumed. Press the Start key on the RISO printer.
- The RISO printer setup is incomplete. Check it. (Blue)
- An error has occurred in an optional equipment. Check the optional equipment. (Yellow)
- The RISO printer setup is wrong. Check it. (Red)
- Paper remains in the optional sorter. Remove it.
- The optional sorter is independently operating. Wait until it finishes operating.
Managing Jobs (Processed Documents)

When you send document data to the SC7900 to print them out on the RISO printer, they are stored in the queue selected as destination in the [Print] dialog box and will be treated as unity in further operations in the RISO Console II. This unity, which is the document data provided with print condition parameters, is called “job” and can be handled in various ways in the RISO Console II.

=Job ownership is...=

When you handle jobs in the RISO Console II, there will be restrictions in operations depending on your operator status. If you handle the jobs you sent to the SC7900 by your own, you can perform all possible operations on them as owner, including changing their print conditions and deleting them from the related queues. If you handle the jobs owned by another user, however, you can only view their properties and copy them into another queue. Depending on the SC7900 configuration, which is controlled by the SC7900 administrator, besides, you will not even be able to view the jobs owned by another user.

Copying jobs into another queue

You can copy a desired job into another queue in the following two ways.

[Procedure 1]
1. Hold a desired job in the list of the main view window with a mouse pointer.
2. Drag and drop it into the target queue.

[Procedure 2]
1. Highlight a desired job name in the list of the main view window.
2. Select [Copy] from the Edit menu.
3. Click on the target queue name and select [Paste] from the Edit menu.

[Applications]
• To save for reprint [normal] queue → [hold] queue
• To print out a saved job [hold] queue → [normal] queue
• To retry a failed job [Finished jobs] queue → [normal] queue
• To preview a job [normal]/[hold] queue → [Archive] queue
• To print out a previewed job [Archive] queue → [normal] queue
• To register a form [normal]/[hold] queue → [Forms] queue
• To print out a form [Forms] queue → [normal] queue

NOTE If you want to change the print conditions of the copied job, hold down the [Shift] key while dragging the selected job to the target queue. The [RISO Console II - Job details] dialog box then appears after dropping the selected job.
Moving jobs into another queue

You can move a desired job into another queue in the following two ways.

[Procedure 1]
1. Hold a desired job in the list of the main view window with a mouse pointer.
2. Drag and drop it into the target queue while keeping the [Ctrl] key held down.

[Procedure 2]
1. Highlight a desired job name in the list of the main view window.
2. Select [Cut] from the Edit menu.
3. Click on the target queue name and select [Paste] from the Edit menu.

[Applications]
- To save for later output  [normal] queue → [hold] queue
- To print out a job saved for later output  [hold] queue → [normal] queue

• Deleting jobs
Highlight a desired job name in the list of the main view window and select [Delete] from the Edit menu.

NOTE  The jobs in a [normal] queue cannot be deleted.

• Suspending current jobs in the [Active jobs] queue
Highlight a desired job name in the list of the main view window and select [Cancel current job] from the Edit menu.

• Changing the output order of jobs in a [normal] queue
Hold a desired job in the list of the main view window with a mouse pointer and drag it to a desired line in the list. Then drop the selected job.

• Changing the display order of jobs in the list
Click on a desired element header in the list of the main view window. Jobs will then be rearranged in the list according to the selected element rule.

Jobs are arranged in the output order in the main window list as default setting, which can be restored at any time by selecting [View by output date] in the Queue menu.

= Retrying failed jobs =

If a print job fails, the corresponding job is placed in the [Finished jobs] queue with the related error descriptions, thus allowing you to retry it by copying it into a [normal] queue. In this case, however, it may be necessary to change print conditions or printer configuration before retry.

The processed jobs which are kept in the SC7900s will be deleted in order according to the rules specified by the SC7900 administrator, e.g. when the storage space becomes full. If jobs are deleted from the SC7900s as specified, they cannot be forwarded to the printing steps any more, although their names still remain in the [Finished jobs] queue.
Exporting Processed Document Data for Preview (Job Feedback)

You can check the document data processed by the SC7900 on your computer screen in advance of their printout, by exporting them as TIFF-format image files for preview.

To export the processed document data as TIFF-format image files, their original data are required to be output to one of special queues, i.e. "Archive" queue, as preparation.

NOTE > This option is available only through the network port.

Outputting document data to the "Archive" queue

To output document data to the "Archive" queue, select "Archive" as output destination and forward a job to a desired "normal" queue. The selected job name is then added to the "Archive" queue in the main view window.

(Windows)

(Macintosh)

NOTE > You can also copy or move a desired job directly to the "Archive" queue for this purpose.

Viewing the image contents of jobs in the "Archive" queue

To allow you to check the image contents of jobs in the "Archive" queue, a thumbnail image view is prepared in this window. Select the "Archive" queue in the guide view and highlight a desired job name in the displayed list. Then select [Feedback] from the File menu.
Exporting processed document data as TIFF-format image file

Several file export options are prepared in the File menu in the [Feedback] dialog box as described below.

[Preview]

To open the TIFF-format image file of a selected page in the current “Archive” job under the browser software which is available on your computer.

[Save page] / [Save page as]

To export the TIFF-format image file of a selected page in the current “Archive” job to your computer, using the current job name or specifying a desired file name. The exported file will be saved in the [RISO SC7900] directory.

[Save job] / [Save job as]

To export all pages of the current “Archive” job as separate TIFF-format image files to your computer, using the current job name or specifying a desired file name. The exported files will be saved in the [RISO SC7900] directory, with the extension page number added to the respective file names.

**IMPORTANT**

Do not print out the preview image files created here because it violates the copyright of the related system development companies.
Merging Document Files

You can merge document files in a unique way, using the archive structure of the RISO Console II. By using the high-resolution (as of printer) bitmap image data of original document files, which are stored in the “Archive” queue, as merge source, individual merged files can be handled separately in reproducing images in the printer while processing them as a unity in print jobs. This unique composition of merged files enables you to print different source images in different colors automatically with a twin-cylinder (-drum) printer.

NOTE This option is only available with a twin-cylinder (-drum) printer.

File Merge Options

To use the file merge options, select desired two jobs in the “Archive” queue and click on [Merge files] in the File menu. The [Merge files] dialog box then appears to provide you with the file merge options as listed below. When you click on the [OK] button in this dialog box, the dialog box is closed and a special combined file is created as a new archive job in the “Archive” queue. To print this special archive job, copy or move it to a “normal” queue.

NOTE To select two archive jobs at the same time, hold down the [Ctrl] key when clicking on the second job name.

The images which are arranged in the top line in the page view frame are to be printed in color 1 and those in the middle line in color 2. The combined images in the bottom line are the previews of the respective pages which are printed on a two-cylinder (-drum) RISO printer.
[Change order] button
Changes the arrangement order of merged file images between the top and middle lines in the page view frame. The print colors of merged file images are also changed accordingly as displayed in the page view frame.

[Paste page] button
Insert the page on which the images of a selected page are pasted after the selected page in the page view frame.

[Copy] button
Copies a selected page in the page view frame.

[Add before] button
Inserts the copied page before a selected page in the page view frame.

[Add after] button
Inserts the copied page after a selected page in the page view frame.

[Insert blank] button
Inserts a blank page before a selected page.

[Delete] button
Deletes a selected page from the page view frame.

[Preview] button
Opens the [Feedback] dialog box for the quick preview of the current merge job.
Printing PostScript/PDF Files

You can print out the PostScript or PDF files which were created on another personal computer by using the RISO Console II, even if the related application software is not installed in your computer. As you can print the files without opening them in advance, in this case, you can prevent someone, including yourself, from changing the contents of original document data by mistake.

Printing Procedure

You can print PostScript or PDF files with the RISO Console II in the following two ways.

- Highlight a desired "normal" queue in the guide view of the main view window and select [Download PS/PDF file] from the File menu. Then select a desired PS or PDF file in the opened dialog box and click on the [Open] button.

- Select a desired PS or PDF file icon on your computer desktop and drag and drop it directly into a desired "normal" queue in the guide view of the RISO Console II main view window.

The selected PS or PDF file is then added to the job list of the corresponding "normal" queue and to be printed under the conditions specified in the selected "normal" queue.

**NOTE** You can also select another queue than a "normal" one, i.e. "hold", "Archive" or "Forms", as destination of PS/PDF files. In this case, the selected PS or PDF files will be processed according to the configuration of the selected queue.
Viewing the List of Installed Fonts

You can check what printer fonts are installed in the memory and hard disk of the SC7900 by opening their list window.

![Font management window](image)

To open the list window of fonts installed in a SC7900, highlight a desired SC7900 name in the guide view of the main view window of the RISO Console II and select [Font management] in the File menu. The fonts to be displayed in the list window will be changed depending on the location selected in the [Show Fonts from] box, i.e. memory or hard disk.

**NOTE** If you want to install other printer fonts in the SC7900, consult your SC7900 administrator.
Extending the Search Range for SC7900

The RISO Console II finds SC7900s in the current network segment, including ones added while this utility program is running, automatically by regular broadcast calls.

If you want the RISO Console II to find SC7900s in another network segment, i.e. beyond a gateway, as well, on the other hand, you are required to list up the IP addresses of desired SC7900s in the RISO Console II.

Procedures

1. Select [Extend search] from the Tools menu in the RISO Console II.
   The [SC7900 list] window then appears.

2. Click on the [Add] button.
   The [Add extension IP address] dialog box then appears.

3. Enter an IP address of a desired SC7900 in the corresponding field and click on the [OK] button.
   The [Add extension IP address] dialog box is closed and the entered IP address is then added to the [SC7900 list] window. Click on the [OK] button to confirm the current SC7900 list.

   ![Add extension IP address dialog box]

   = To change the IP address of a desired SC7900 in the [SC7900 list] window =
   Select the corresponding IP address in the [SC7900 list] window and click on the [Modify] button. Then enter a new IP address in the opened dialog box and click on the [OK] button.

   **NOTE** This operation makes no effect on the IP address which is assigned to the SC7900 itself. It can be changed only by the SC7900 administrator.

   = To delete a desired SC7900 from the [SC7900 list] window =
   Select the corresponding IP address in the [SC7900 list] window and click on the [Remove] button.
Changing the RISO Console II Properties

You can change the properties of the RISO Console II in the [Properties] dialog box according to the operation environment of your computer. To open the [Properties] dialog box, select [Properties] in the Tools menu.

![Properties dialog box]

**Communication type**
If the SC7900 is connected to your computer with a serial cable, select the serial port assigned to the SC7900. If the network cable is used in this case, on the other hand, leave “Network” selected.

**Language**
You can select the language to be used in the RISO Console II from the displayed list.

**Application for preview**
You can specify the application software which automatically runs to open the TIFF-format image file of an “archive” job for preview on your computer screen. The browser software which is installed in your computer as standard will be selected in the above case if you specify none here. (See page ##.)

**Application for Help**
You can specify the application software which automatically runs to open the Help file. The browser software which is installed in your computer as standard will be selected in the above case if you specify none here.
Scanning Images on your RISO Printer

RISO Printer Scanning ......................... 106

Importing Scanned Images directly into a Document Page ......................... 107

Saving Scanned Images as TIFF Files ...... 109

Exporting Scanned Images through the RISO Console II ......................... 111

Scanning Images ............................. 111

Exporting Images ................. 111

Scanning Images
You can scan images on your RISO printer and capture them into your computer in the following three ways.

- Directly into a document page in the TWAIN compatible application software
- In the form of TIFF file through the dedicated scanning utility, RISO Scan
- In the form of TIFF file through the dedicated document management utility, RISO Console II

You can capture only one page image into your computer at one time if you scan from the TWAIN-compatible application software, while multiple page images (up to 99 pages) can be scanned and saved in TIFF format if you use the RISO Scan or the RISO Console II.

Select one of them according to your needs.

**NOTE** You can capture the images scanned on your RISO printer into your computer only through a network cable.
Importing Scanned Images directly into a Document Page

You can import a desired image directly into your document by scanning it on your RISO printer and capturing it through the TWAIN driver. If you proceed to import an image from a scanner in a TWAIN-compatible application software, the following dialog box will appear to allow you to control your RISO printer scanner from your desktop.

For detailed descriptions about the procedure of importing an image in your TWAIN-compatible application software, refer to the manuals of the application software concerned.

= Basic operation in this dialog box =

1. Place an original sheet on your RISO printer.
2. Select the scanning mode and density level in the [Image Settings] window.
3. Click on the [Scan] button.
4. Specify an image area to be captured into your document in the [Preview] or [Region] window.
5. Click on the [Acquire] button.

a. Scanning Site Data Window

Indicates the capability of the SC7900 printer site to be used for scanning operation, such as scanning resolution and duo mode's availability. If you want to use another SC7900 printer site which is also available for your computer, click on the [▼] bar in the site display box and highlight a desired one in the displayed list.
b. [Preview] Window

Displays the preliminarily-scanned page image, thus allowing you to specify the image area to be captured into your document or TIFF file. The red crop frame line indicates the image area to be captured and its size and position will be automatically changed according to the settings specified in the [Region] window.

NOTE: You can also change the size and position of this frame by directly moving the frame line while dragging the mouse pointer in the [Preview] window.

c. [Region] Window

Indicates the current size and position of the red crop frame in the [Preview] window.

The image enclosed by this frame will be captured into your document or TIFF file. If you want to specify another image in the [Preview] window, change the size (W, H) and position (X, Y) of this frame by entering desired values in the corresponding boxes in this window while selecting a desired unit of length, “inches” or “mm”, from the [Unit] box. The frame size will also be changed according to the paper size selected in the [Format] box.

NOTE: You can also change the size and position of this frame by directly moving the frame line while dragging the mouse pointer in the [Preview] window.

d. [Image] Window

You can select the scanning mode and density for an image to be captured. The available scanning modes and density levels are as follows.

Mode: Line, Photo and Duo

Density: Lightest, Light, Medium Light, Standard, Medium Dark, Dark and Darkest

NOTE:
- The scanning mode which is not supported in your selected SC7900 printer site will not be selected from this list.
- When your selected SC7900 printer site has only 5 scanning density levels, two medium density levels will be automatically adjusted to those of “Light” and “Dark” respectively.

e. Invert Image

You can invert black and white in a scanned image if you tick this option box.

f. [Acquire] button

Imports a scanned image into your document.

g. [Scan] button

Activates your RISO printer scanner and views a scanned page image in the [Preview] window.
Saving Scanned Images as TIFF Files

You can scan a desired image on your RISO printer and save it as a TIFF-format file, using the dedicated scanning utility, RISO Scan. This allows you to keep various image files in stock in your computer at one time and use them later whenever you want. The maximum of 99 images can be scanned and saved as TIFF-format files with one key operation. When you start the RISO Scan, the following dialog box will appear.

= Operation procedure =

1. Start the RISO Scan.
   - Windows: Select [RISO SC7900] from the [Program] folder in the [Start] menu and click on [SC7900 Scan].
2. Place an original sheet on your RISO printer.
3. Select the scanning mode and density level in the [Image Settings] window.
4. Click on the [Scan] button.
5. Specify an image area to be saved in a TIFF file in the [Preview] or [Region] window.
6. Specify several conditions under which the specified image is to be saved in the [Save] window.
7. Click on the [Save] button.
- [Save] Window -

a. **Path:** Specify the location in which the scanned images are to be saved. Click on the button to specify a desired directory in the [Select Image Path] dialog box.

b. **Basename**
Enter a name you want to give to the saved TIFF files. If you scan multiple pages of images using the ADF feature on your RISO printer, the respective images will be saved in separate TIFF files, given sequential numbers after the specified base name.

NOTE: A TIFF file can store only a single page of image.

c. **Number of originals:**
You can specify the number of pages of images to be scanned and saved under the file names with the identical base name specified above when you scan multiple pages of images at one time. You can specify the number up to "99".

d. **Compressed TIFF**
You can compress the TIFF files which are to save images. To compress them, tick this option box.

e. **[Save] button**
Saves the image specified in the [Preview] window in the TIFF file as specified in the [Save] window.

NOTE: For descriptions about other windows in this dialog box, refer to the section titled “Importing Scanned Images directly into a Document Page”.
Exporting Scanned Images through the RISO Console II

You can scan a desired image on your RISO printer and store it as a TIFF-format file in the “Scan” queue in the SC7900. The TIFF-format files which are stored in the “Scan” queue can then be exported to your computer by using the Feedback option of the dedicated document management utility, RISO Scan II. By using the SC7900 as the stock point of scanned images in this way, you can stay by your RISO printer and select appropriate scanning conditions on the control panel of the printer while scanning images. Besides, all network users can share the scanned images and apply them to one’s own documents whenever desired by using the SC7900 as a file server.

Scanning Images

1. Select the copy mode as job mode on the control panel of your RISO printer and then place an original on the printer.
2. Change the job mode to the data mode. The image scanning operation will then start automatically. When the operation is completed, a “scan” job (scanned image data) is added to the “Scan” queue in the SC7900.

Exporting Images

1. Open the RISO Console II main view window and select the “Scan” queue in the guide view. The “scan” jobs stored there are then displayed in the list view frame.
2. Highlight a desired “scan” job in the list view frame and select [Feedback] in the File menu. The [Feedback] dialog box will then appear, presenting the thumbnail image view of the selected job.
3. Select a desired file export option from the File menu. The selected “scan” job will then be exported to your computer as TIFF-format image file.

NOTE As for the descriptions about the file export options, refer to the section “Exporting Processed Document Data for Preview (Job Feedback)” on page ##.
Appendix

Viewing SC7900 Configuration in an Internet Browser ......................... 114
Web Site Overview ........................................ 114
Troubleshooting Tips ....................................... 116
Operation Problems ........................................ 116
Index .................................................................. 120
Windows ......................................................... 120
Macintosh ....................................................... 123
The SC7900 printer station has a built-in HTTP server function to enable you to view the SC7900 configuration using your standard Internet browser as with the RISO Console II.

The Internet browsers which support this function are; Microsoft Internet Explore 4.0 or above

And Netscape Communicator 4.0 or above.

For descriptions about the contents of the SC7900 configuration displayed on the Web site pages, refer to the pages ## - ##.

To open the Web site pages of a desired SC7900 printer station, open your Internet browser and enter the IP address of the selected SC7900 printer station in the Internet address field.

Web Site Overview

The home page of the SC7900 Web site shows the current “normal” and “hold” queue structure of the selected SC7900 printer station while indicating the configuration and status of the respective queues.

The menu items which are available in the SC7900 Web site, besides, are listed in the left-hand column of pages as described below and the contents of the item which is selected in the left-hand list will be displayed in another area on the pages.
Viewing SC7900 Configuration in an Internet Browser

- Queues and jobs: Shows the home page of the SC7900 Web site.
- Active jobs: Shows the jobs under processing in the selected SC7900 printer station.
- Feedback jobs: Shows the bitmap image files of documents which are prepared in the selected SC7900 printer station for feedback or preview.
- RIP Status: Shows the detailed configuration of the selected SC7900 unit.
- Finished jobs: Shows the jobs which have been processed in the selected SC7900 printer station.
- Engine Status: Shows the detailed configuration of the RISO printer which is connected to the selected SC7900 printer station.
- Log In/Out: Shows the password entry page for the administrator.
- Language: Shows the page in which you can select the language to be used in this Web site.

**NOTE**

The detailed configuration of queues and jobs can be viewed by clicking on the corresponding [Details] icon in the respective lists.

The list of the jobs stored in a “normal” or “hold” queue can be viewed by clicking on the corresponding [Job] icon in the queue list.
### Troubleshooting Tips

#### Operation Problems

Check your SC7900 printer station as given below if you encounter the following operation problems. Contact your SC7900 administrator for help if you cannot solve the problem.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause/Condition</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The SC7900 has no power even when the POWER button is pressed.</td>
<td>The main power switch on the rear panel is not turned on.</td>
<td>Turn it on. —— See page 12 in the Technical Administrator’s Guide.</td>
</tr>
<tr>
<td></td>
<td>The power cord is not connected to the SC7900 or the electrical outlet securely.</td>
<td>Connect it securely.</td>
</tr>
<tr>
<td></td>
<td>The commercial power may not be present at the electrical outlet.</td>
<td>Check the circuit breaker for commercial power. If you find no problem there, connect another electrical appliance to the electrical outlet in question to check it.</td>
</tr>
<tr>
<td>The READY/DATA indicator does not flash even after the print job finishes in the application software. (In this case, it is suspected the SC7900 is not receiving data from the personal computer.)</td>
<td>The personal computer is not securely connected to the SC7900.</td>
<td>Contact your SC7900 administrator.</td>
</tr>
<tr>
<td></td>
<td>The [SC7900] printer driver is not selected.</td>
<td>Select the [SC7900] printer driver and reprint.</td>
</tr>
<tr>
<td>The READY/DATA indicator keeps on flashing slowly without any RISO printer operation even after the print job finishes in the application software.</td>
<td>The printer settings (paper size, print orientation, etc.) in the application software and in the printer driver do not match.</td>
<td>Change the printer settings in the application software to make them identical with those in the printer driver or vice versa, and repeat the print job from the application software.</td>
</tr>
</tbody>
</table>
## Troubleshooting Tips

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause/Condition</th>
<th>Action</th>
</tr>
</thead>
</table>
| The PAGE STANDBY indicator is flashing. | The RISO printer's operation has been suspended intentionally or accidentally. | Press one of the following buttons to resume operation according to the suspended condition: START button (or the Interface key on the RISO printer), STOP button or FUNCTION button. 
— See page 11. |
<p>| The ERROR indicator is illuminated. | An error has occurred in the RISO printer, interrupting its operation. | After checking the RISO printer, press one of the following buttons to resume operation according to the error condition: START button (or the Interface key on the RISO printer), STOP button or FUNCTION button. |
| The ERROR indicator is flashing. | The RISO printer is not switched on. | Turn on the RISO printer. | The SC7900 is not connected to the RISO printer securely. | Contact your SC7900 administrator. |
| The RISO printer repeats the master-making process for each copy of the identical page. | The [Collate] check box is selected in the [Print] dialog box in the application software. | Cancel the current print job on the RISO Console II referring to page xx. Always cancel the [Collate] option in the [Print] dialog box when starting a print job. |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause/Condition</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The page image is not centered or is clipped at an edge.</td>
<td>The paper size setting in the application software is not identical with that in the printer driver.</td>
<td>Make both paper size settings identical.</td>
</tr>
<tr>
<td></td>
<td>The print area specified in the application software is beyond the maximum print area of the RISO printer.</td>
<td>Increase the border margins in the application software to contain the page image within the printable area of the RISO printer.</td>
</tr>
<tr>
<td></td>
<td>There is something wrong with the Print cylinder (drum) in the RISO printer.</td>
<td>Check the RISO printer, referring to the dedicated user’s guide.</td>
</tr>
<tr>
<td>The RISO printer prints more copies than expected.</td>
<td>The number of copies in the [Proof Copies] option is specified as more than 1 as initial setting.</td>
<td>Correct the number of copies to “1” in the [Proof Copies] option before printing or request your SC7900 administrator to return the initial setting of this option to the factory-set one.</td>
</tr>
<tr>
<td>The RISO printer cannot print at the speed specified in the [Print Speed] option.</td>
<td>The print speed remains constant when a certain mode is selected in the [Sorter control] option for the RISO printer which is equipped with a certain type of optional sorter.</td>
<td>Refer to page 24 and 85 for detailed descriptions about the [Sorter control] option.</td>
</tr>
<tr>
<td>The RISO printer does not operate as specified in the [Sorter control] option.</td>
<td>The [Sorter control] option is not enabled without an optional sorter installed.</td>
<td>Refer to page 23, page 52 or page 84 for a detailed description about the [Sort Mode] option.</td>
</tr>
<tr>
<td></td>
<td>The finishing job specified in the [Sorter control] option is not available for the current combination of RISO printer and optional sorter.</td>
<td>Refer to the dedicated user’s guides of the RISO printer and the optional sorter.</td>
</tr>
<tr>
<td>Problem</td>
<td>Cause/Condition</td>
<td>Action</td>
</tr>
<tr>
<td>---------</td>
<td>----------------</td>
<td>--------</td>
</tr>
<tr>
<td>A desired finishing job cannot be selected in the [Sorter control] option.</td>
<td>The optional sorter configuration specified in the [SC7900] printer driver is not identical with your SC7900 printer station setup.</td>
<td>Request your SC7900 administrator to correct the current optional sorter configuration in the [SC7900] printer driver.</td>
</tr>
<tr>
<td>A desired paper size cannot be selected in the [Paper Size] list.</td>
<td>The Printer cylinder (Drum) size specified in the [SC7900] printer driver is not identical with your SC7900 printer station setup.</td>
<td>Request your SC7900 administrator to correct the current Print cylinder (Drum) size setting in the [SC7900] printer driver.</td>
</tr>
</tbody>
</table>
Index

Windows

A
[About] button ........................................ 19
ABS Screening .................................. 20, 23
[Aquire] button .................................. 106
Activate the RISO Console II ................. 91
Adobe Brilliant Screens ....................... 23
Adobe Document Structuring Conventions
   (ADSC) ........................................ 26
Archive format .................................. 26
Auto Print ........................................ 24

B
Basename ......................................... 108
booklet ........................................... 30

C
Collate ............................................ 14
Compressed TIFF .............................. 108
Confidential Mode .............................. 24
Conflict .......................................... 22
Console II Main Window ....................... 91
Console II Overview ............................ 90
(Status of) Consumable ......................... 97
Copies ............................................ 19
create EPS file .................................. 26
Creating a PS File ............................... 42
Creating Form .................................. 38
Creating/Superimposing Forms ............... 38
Creep compensation ........................... 31
Current Setting ................................ 24
[Custom] button ................................ 19

D
Dark Shades ..................................... 24
Delegation ....................................... 36
[Delete] button ................................ 28
Device .......................................... 36
[Device Options] Tab ......................... 16, 22
dialog box ....................................... 105
Direct (Queue) .................................. 93
Download PS/PDF File ......................... 98
Drag and Drop Files on to the Queue ....... 99

E
[Edit] button .................................... 28
Editing the Job Settings ....................... 95
Encapsulated PostScript [EPS] ................ 26
(Status of) Error ................................ 97
Error in master-making ....................... 11
Error in printing ............................... 11
ERROR indicator .............................. 10, 11

F
FM screens ..................................... 23
FUNCTION button .............................. 10, 11, 25

G

H
Halftoning ....................................... 20

I
Image Control .................................. 24
[Image] Window ................................. 106
Importing scanned Image directly
   into a Document Page ....................... 105
Impoting Scanned Images through the
   RISO Console II ............................ 109
Interface key .................................. 25
[Invert Image] button ......................... 106

J
Job Feedback .................................. 100
Job Management ............................... 94

L
Landscape ....................................... 19
Layout .......................................... 19, 30
Light Shades .................................. 24
Index

M
mirror image ........................................... 21
Monitoring the RISO Printer Status ................. 96

N
negative image .......................................... 21
[New] button .............................................. 28
Normal Type of Queue .................................. 93
Number of originals ..................................... 108

O
Orientation .................................................. 19
Overall Density .......................................... 24

P
PAGE STANDBY indicator ............................. 10, 11, 15
Panel Settings ............................................ 24
Paper size ................................................... 18
Paper source ............................................. 19
[Paper] Tab .................................................. 16, 18
pause in job .............................................. 25
Portrait ..................................................... 19
PostScript [optimize for portability-ADSC] .......... 26
PostScript [optimize for speed] ....................... 26
PostScript output format ................................ 26
[PostScript] Tab .......................................... 17, 26
POWER button ............................................ 10
[Preview] Window ........................................ 106
Print Density ............................................. 24, 33
[Print] dialog box ....................................... 14
Print Even / Odd Pages .................................. 25
Print Speed ............................................... 24, 33
Print Status Icon ....................................... 96
Print watermark ......................................... 28
Printer features ......................................... 22
Printing Jobs ............................................. 94
Prohibition ................................................ 22
Proof Copies ............................................. 25
Properties ............................................... 15, 16

R
READY / DATA indicator ............................... 10, 15
[Region] Window ......................................... 106
Resolution ................................................. 20
RIP .......................................................... 2
RIP List .................................................. 102
RISO List .................................................. 107
Rotated (Rotate 180°) .................................... 25

S
Safety Guides .............................................. 8
[Save] button ............................................. 108
[Save] Window ........................................... 108
Saving scanned images ................................ 107
[SC7900] Tab ............................................ 17, 29
[SC7900] Tab-[About] Window ....................... 37
[SC7900] Tab-[Controls] Window ..................... 33
[SC7900] Tab-[Forms] Window ....................... 35
[SC7900] Tab-[Screening] Window ................. 32
Scaling ....................................................... 21
scan ......................................................... 104
[Scan] button ........................................... 106
Scanning Site Data Window .......................... 105
Screen angle ............................................... 20
Screen frequency ........................................ 20
Select a Watermark ..................................... 27
Send E-mail ............................................... 36
Sending and Printing Data ......................... 14
Setting the Print Conditions ....................... 16
Shift compensation ................................... 31
Sort Mode ............................................... 23, 30
Special .................................................... 21
Specifying Files with the Dialog Box ............ 98
Staple Mode ............................................. 23
START button .......................................... 10, 11, 25
Start the RISO Scan .................................. 107
STOP button ............................................ 10, 11, 25
Superimposing a Form to the Document ........ 40

T
Tape Sort Mode ........................................ 34
TIFF-format file ........................................ 107
Types of Queue ....................................... 93
TWAIN driver ........................................... 105
Index

U
[Unprintable Area] button .......................... 19
Use the SC 7900 Control Box out of your
Subnetwork (Edit RIP LIST) .................. 102

V
Viewing and Editing the Job Settings ........ 95

W
[Watermarks] Tab .................................. 17, 27
Macintosh

A
[Aquire] button ........................................ 106
Activate the RISO Console II .................. 91
Adobe Brilliant Screens .......................... 85
AdobePS .............................................. 60
[AdobePS Page Setup] Dialog Box ............. 64
Auto Print ........................................... 76, 86

B
[Background Printing] Card ....................... 77
Background printing feature ...................... 77
Basename ............................................ 108
Black&White ........................................ 79
Booklet ............................................... 66, 71
Border ................................................. 80

C
[Chooser] dialog box ............................... 60
Collate ............................................... 87
[Color Matching] Card ............................ 79
Color/Grayscale ..................................... 79
Compressed TIFF .................................. 108
Confidential Mode .................................. 75, 85
Console II Main Window ......................... 91
Console II Overview ................................ 90
(Status of) Consumable ............................ 97
[Cover Page] Card .................................. 78
Current Setting ...................................... 85
Custom Page Default .............................. 65
[Custom Page Default] Card ....................... 65

D
Dark Shades ......................................... 85
Data Format ......................................... 83
Delegation .......................................... 73
desktop printer ...................................... 63
Device ................................................ 73
Destination .......................................... 82
dialog box .......................................... 105
Direct (Queue) ...................................... 93
Download PS/PDF File .......................... 98
Drag and Drop Files on to the Queue ......... 99

E
[Edit...] button ...................................... 67
Editing the Job Settings ......................... 95
EPS file ............................................. 83
[Error Handling] Card ............................ 81
(Status of) Error .................................... 97
Error in master-making ........................... 11
Error in printing .................................... 11
ERROR indicator .................................... 10, 11

F
Flip Horizontal ..................................... 69
Flip Vertical ........................................ 69
FM screens ........................................... 85
Font Inclusion ....................................... 83
Foreground .......................................... 67
Foreground printing feature ..................... 77
Format ............................................... 82
FUNCTION button .................................. 10, 11, 86

H
Hold Queue .......................................... 64

I
ID Density / IC Contrast ......................... 85
If there is a PostScript™ error .................. 81
Image & Text .......................................... 69
[Image] Window ...................................... 106
Importing scanned Image directly into a Document Page .................. 105
Importing Scanned Images through the RISO Console II .................. 109
Interface key ........................................ 86
Invert Image ........................................ 69
[Invert Image] button .............................. 106
| J | Job Feedback ............................................. 100 |
| L | [Layout] Card ........................................... 71, 80 |
| | Layout direction ....................................... 80 |
| M | Margins .................................................. 66 |
| | Monitoring the RISO Printer Status ................... 96 |
| N | None / First / All ................................... 67 |
| | Normal Type of Queue ................................ 93 |
| | Number of originals .................................. 108 |
| O | Orientation .............................................. 66 |
| P | [Page Attributes] Card ................................ 64, 65 |
| | [Page Setup] dialog box ................................ 61 |
| | PAGE STANDBY indicator .............................. 10, 11, 63, 86 |
| | Pages per sheet ....................................... 80 |
| | Panel Settings ......................................... 85 |
| | Paper ...................................................... 65 |
| | pause in job ............................................ 86 |
| | PICT / EPS .............................................. 67 |
| | PostScript error ........................................ 81 |
| | PostScript file ........................................ 83 |
| | PostScript Level ....................................... 83 |
| | [PostScript™ Options] Card ......................... 64, 69 |
| | [PostScript Settings] Card ......................... 82 |
| | POWER button .......................................... 10 |
| | PPD Limits ............................................. 66 |
| | Precision Bitmap Alignment ......................... 70 |
| | [Preview] Window ..................................... 106 |
| | Print Color ............................................ 79 |
| | Print Cover Page ...................................... 78 |
| | Print Data file ........................................ 82 |
| | Print Density ......................................... 75, 85 |
| | [Print] Dialog Box ..................................... 62, 64 |
| | Print Even / Odd Pages ............................... 86 |
| | Print in ............................................... 77 |
| | Print on Both Sides .................................. 80 |
| | Print Speed .......................................... 75, 85 |
| | Print Time ............................................ 77 |
| | Printer ............................................... 65 |
| | Printer Profile ....................................... 69, 79 |
| | Printer Status Icon .................................. 96 |
| | [Printer Specific Options] Card .................... 84 |
| | Printing Jobs ......................................... 94 |
| | Proof Copies ......................................... 76, 86 |
| R | READY / DATA indicator .............................. 10, 63 |
| | [Region] Window ....................................... 106 |
| | RIP ....................................................... 2 |
| | RIP List ................................................ 102 |
| | RISO Scan .............................................. 107 |
| | Rotated (Rotate 180°) ................................ 71, 86 |
| | RS15 Output Dev. ...................................... 87 |
| | RS16 Delegation ....................................... 87 |
| S | Safety Guides ......................................... 8 |
| | [Svac] button ......................................... 108 |
| | [Save Settings] button .............................. 87 |
| | [Save] Window ........................................ 108 |
| | Save With Document .................................. 67 |
| | Saving scanned images ............................... 107 |
| | SC7900-direct ....................................... 60 |
| | [SC7900 Forms] Card ................................ 72 |
| | [SC7900 Gamma] Card ................................ 74 |
| | SC7900-hold .......................................... 61 |
| | [SC7900 Layout] Card ................................ 71 |
| | SC7900-normal ........................................ 61 |
| | [SC7900 Workflow] Card ............................ 73 |
| | Scale .................................................... 66 |
| | scan .................................................... 104 |
| | [Scan] button ......................................... 106 |
| | Scanning Site Data window ......................... 105 |
| | Screening Mode ...................................... 85 |
Index

Send e-mail ................................................. 73
Sending and Printing Data ......................... 60
Setting the Print Conditions ....................... 64
Smooth Graphics ......................................... 69
Smooth Text .............................................. 69
Sort Mode ................................................. 71, 84
Specifying Files with the Dialog Box .............. 98
Staple Mode .............................................. 71, 84
START button ........................................... 10, 11, 86
Start the RISO Scan .................................... 107
STOP button ............................................. 10, 11, 86
Substitute Fonts ......................................... 69

T
Tape Sort Mode ......................................... 76
TEXT .......................................................... 67
TIFF-format file .......................................... 107
Types of Queue .......................................... 93
TWAIN driver ............................................. 105

U
Unlimited Downloadable Fonts ....................... 70
Use the SC 7900 Control Box out of your
Subnetwork (Edit RIP LIST) ......................... 102

V
Viewing and Editing the Job Setting ............... 95
Visual Effects ............................................ 69

W
[Watermark] Card ....................................... 67